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EU Declaration of Conformity 
 
This declaration of conformity is issued by the manufacturer. 
The development/evaluation tool is designed to be used for research and development in a laboratory environment.  This 
development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made 
commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European 
Commission's Guide for the EMC Directive 2004/108/EC (8th February 2010).  
This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU. 
This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential 
requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity 
provided in the module datasheet and the module product page available at www.microchip.com. 
For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and 
conditions of sale, which are printed on our sales documentation and available at www.microchip.com. 
Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA.

声明对象：MPLAB ICD-4在线调试器
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前言

简介

本章包含使用MPLAB ICD 4在线调试器前需要了解的一般信息。内容包括：

• 文档编排

• 本指南使用的约定

• 推荐读物

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXXXXA_CN”，其中 “XXXXXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参考 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。

http://www.microchip.com
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文档编排

本文档介绍了如何使用MPLAB ICD 4在线调试器作为开发工具在目标板上仿真和调试
固件，以及如何对器件编程。文档内容编排如下：

第1部分——使用入门

• 第1章“关于调试器”——介绍了MPLAB ICD 4在线调试器的概念及其如何助您开
发应用。

• 第2章“工作原理”—— MPLAB ICD 4在线调试器工作原理。介绍了配置选项。

• 第3章“调试器使用”——介绍了选择MPLAB ICD 4在线调试器作为调试工具时，
MPLAB X IDE中提供的基本调试功能。其中包括断点和跑表调试功能。

第2部分——故障诊断

• 第4章“故障诊断首要步骤”——调试器运行出现问题时首先应该尝试的操作。

• 第5章“常见问题解答（FAQ）”——常见问题列表，有利于故障诊断。

• 第6章“错误消息”——错误消息和建议解决方案的列表。

第3部分——参考信息

• 附录A“调试器功能汇总”——选择MPLAB ICD 4调试器作为调试或编程工具时，
MPLAB X IDE中提供的调试器功能汇总。

• 附录B“硬件规范”——调试器系统的硬件和电气规范。

• 附录C“版本历史”
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本指南使用的约定

本指南采用以下文档约定：

文档约定

说明 表示 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide

需强调的文字 ……为仅有的编译器……

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选择 选择 Enable Programmer

引用 窗口或对话框中的字段名 “Save project before build”

带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK

选项卡 单击 Power 选项卡

N‘Rnnnn verilog 格式的数字，其中 N
为总位数， R 为基数， n 为
其中一位。

4‘b0010， 2‘hF1

尖括号 < > 括起的文字 键盘上的按键 按下 <Enter>， <F1>

Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm， _endasm， static

命令行选项 -Opa+，-Opa-

二进制位值 0， 1

常量 0xFF， ‘A’

斜体 Courier New 可变参数 file.o， 其中 file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [选项] file [选项]

花括号和竖线： { | } 选择互斥参数； “或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}
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推荐读物

本用户指南介绍了如何使用MPLAB ICD 4在线调试器。下面列出了其他有用的文档。
以下Microchip文档均已提供，并建议读者作为补充参考材料。

多工具设计忠告（DS51764C_CN）

请先阅读本文档！本文档包含有关在使用MPLAB ICD 4进行目标设计时应考虑的操作
问题的重要信息。

MPLAB X IDE在线帮助

这是在使用任何Microchip硬件工具时的必备文档。

这是MPLAB X IDE的扩展帮助文件。它包括嵌入式系统的概述、安装要求、教程以及
创建新项目、设置编译属性、调试代码、设置配置位、设置断点以及编程器件等方面
的详细信息。此帮助文件通常比可以从http://www.microchip.com/mplabx/免费下载的
用户指南（DS50002027）的PDF内容更新。

MPLAB ICD 4在线调试器的版本说明

有关使用MPLAB ICD 4在线调试器的最新信息，请阅读MPLAB X IDE Start Page（起
始页）上“Release Notes and Support Documentation”（版本说明和支持文档）下
的说明。版本说明包含本用户指南中可能未提供的更新信息和已知问题。

MPLAB ICD 4快速入门指南宣传页（DS50002538A_CN）

该宣传页介绍了如何使用标准通信和目标板为MPLAB ICD 4在线调试器连接硬件和安
装软件。

MPLAB ICD 4在线调试器在线帮助文件

MPLAB X IDE随附了全面的调试器帮助文件。内容涵盖了调试器的使用、故障诊断和
硬件规范。此帮助文件可能比文档内容更新。 

处理器扩展包（PEP）和调试头规范（DS50001292W_CN）

本小册子介绍了如何安装和使用调试头。调试头可用来更好地调试所选器件，无需占
用额外的引脚和资源。另请参见PEP和调试头在线帮助文件。

Transition Socket Specification（DS51194）

可参考本文档获取有关适用于调试头的转换插座的信息。

http://www.microchip.com/mplabx/
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第1章 关于调试器

1.1 简介

本章提供了MPLAB® ICD 4在线调试器系统的概述。

• MPLAB ICD 4在线调试器说明

• MPLAB ICD 4在线调试器的优势

• MPLAB ICD 4在线调试器组件

• MPLAB ICD 4框图

1.2 MPLAB ICD 4在线调试器说明

MPLAB ICD 4在线调试器（DV164045）是Microchip最快且最经济高效的调试和编
程工具，适用于Microchip PIC®、dsPIC®闪存和CEC（基于ARM® Cortex®-M4）单片
机。可与功能强大且拥有易于使用的图形用户界面的MPLAB X集成开发环境（Integrated
Development Environment，IDE）配合使用，进行调试和编程。MPLAB ICD 4通过高
速USB 2.0接口连接到PC，并通过RJ-11连接器连接到目标板。MPLAB ICD 4也可使
用JTAG接口。

由于该调试器系统使用带有内置仿真电路的器件（而非特殊调试器芯片），因此执行
代码的方式与实际器件相似。通过该调试器系统可以交互方式访问给定器件的所有可
用功能，且可通过MPLAB X IDE界面设置和修改这些功能。

MPLAB ICD 4在线调试器兼容以下任意平台：

• Microsoft Windows® 7或更高版本

• Linux®

• macOS™

MPLAB ICD 4调试器专为调试嵌入式处理器而开发，具有丰富的调试功能，嵌入式处
理器在以下方面与传统系统处理器有所不同：

• 处理器以最大速度运行

• 能够集成 I/O端口数据输入

• 高级主机通信接口（Windows、macOS和Linux）

• 高级通信介质和协议

• 编程时间更短

• 模块化设计（可测试性和可维护性）

除了调试器功能外，MPLAB ICD 4在线调试器系统也可用作器件生产编程器。
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1.3 MPLAB ICD 4在线调试器的优势

MPLAB ICD 4在线调试器系统具有以下优势：

特性 /功能

• 通过高速USB 2.0（480 Mbps）电缆连接到计算机。

• 附带标准的Microchip调试连接器（RJ-11），并可选择使用JTAG。

• 使用MPLAB X IDE或MPLAB IPE编程器件。

• 支持多个断点、跑表和源代码文件调试。

• 实时调试您自己的硬件上的应用程序。

• 根据内部事件设置断点。

• 监视内部文件寄存器。

• 全速调试。

• 配置引脚驱动器。

• 可通过MPLAB X IDE固件下载进行现场升级。

• 通过安装最新版本的MPLAB X IDE（可从http://www.microchip.com/mplabx/免费
下载）添加新的器件支持和功能。

• 控制LED的亮度。

• 包括可以测试所有通信的测试模块。

性能 /速度： 

• 性能更高、速度更快的存储器。

• 实时操作系统（Real-Time Operating System，RTOS）。

• 更换器件时不会发生固件下载延迟。

• 在300 MHz频率下运行的32位MCU。

• 2 MB缓冲存储器。

安全性：

• 当目标需要外部电源时，从调试器接收反馈。

• 支持1.2V至5.5V的目标电源电压。

• 使用可选的9V DC电源实现最高1A的安全供电。

• 在探针驱动器中添加保护电路，以便免受来自目标应用的电源浪涌的危害。

• VDD和VPP电压监视器用于过压情况的保护 /所有线路均具备过电流保护。

• 在确定电压对连接、可编程电阻值和方向（上拉、下拉或不存在）安全之前，编程 /
调试引脚在物理上是隔离的。

• 可控编程速度提供了灵活性，能够克服目标板设计问题。

• 符合CE和RoHS标准——符合行业标准。

http://www.microchip.com/mplabx/
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1.4 MPLAB ICD 4在线调试器组件

MPLAB ICD 4在线调试器系统的组件包括：

• 一个采用耐用黑色外壳的球形MPLAB ICD 4设备，配有LED指示灯排、Mini-B USB
连接器、RJ-45连接器和电源连接器（9V DC +/-5%，中心为正极，2.5 mm内径 /
5.5 mm外径）。

• Mini-B USB电缆，用于提供调试器和计算机之间的通信以及从计算机向调试器
供电。

• 6英寸模块化电缆（6引脚RJ-11型），用于将MPLAB ICD 4设备连接到调试头模块
或目标板。

• 用于调试器自检的 ICD测试接口模块（AC164113）。

图1-1： 基本调试器系统

其他硬件和附件可以从Microchip Direct（http://www.microchipdirect.com/）单独订购。

• 9V直流电源（部件编号AC002014），110-220V通用电源，为目标应用提供最高1A
的电流（https://www.microchipdirect.com/product/search/all/AC002014）。 

• 转换插座。

• ICD调试头。

• MPLAB处理器扩展工具包。

Mini USB 电缆

指示
条

模块化电缆
连接到目标板、
转接头或 ICD

ICD 测试接口
板

测试接口
板

ICD 测试接口模块

Mini-B USB电缆

模块化电缆

http://www.microchipdirect.com/
https://www.microchipdirect.com/product/search/all/AC002014
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1.5 MPLAB ICD 4框图
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第2章 工作原理

2.1 简介

本章简要概述了MPLAB ICD 4在线调试器系统的工作原理。旨在提供足够的信息，来
帮助用户设计与调试器兼容的目标板，以进行调试和编程操作。本章还讨论了在线调
试和编程的基本原理，以便用户能够快速地解决遇到的问题。

• 调试器与目标板之间的通信

• 目标板通信连接

• 调试

• 调试要求

• 编程

• 调试器使用的资源

2.2 调试器与目标板之间的通信

调试器通过USB电缆连接到计算机，以实现通信和调试器供电（非目标板供电）。 

将调试器连接到目标应用以进行通信和数据收集。有关引脚排列的信息，请参见
第B.5.1节“将RJ-11型电缆连接到MPLAB ICD 4在线调试器上的RJ-45插座”。

将电源（需额外购买）连接到目标应用（首选方法）或由调试器向目标板供电。

以下小节介绍了调试器系统配置。 

注： 在连接MPLAB ICD 4在线调试器之前，必须先安装MPLAB X IDE软件。

注意

通信故障。
在安装软件和USB驱动程序之前，请勿连接硬件。

注意

调试器或目标板损坏。
在调试器或目标板通电时，请勿更改硬件连接。
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2.2.1 标准 ICSP器件通信

可将调试器系统配置为使用标准6引脚 ICSP（模块化电缆）通信连接来执行编程和调
试功能。模块化电缆可以插入到： 

• 目标板上的配套插座，即目标器件在目标板上的位置（图2-1）。

• 标准适配器 /调试头板组合（可用作处理器扩展包），随后插入目标板（图2-2）。

有关标准通信的更多信息，请参见第B.5.2节“标准通信”。

图2-1： 标准调试器系统——具有片上 ICE电路的器件

注： 较早的调试头板使用6引脚（RJ-11型）模块化连接器而非8引脚连接器，因
此这些调试头可以直接连接到调试器。

目标板

目标器件

为目标板或调试器供电的外部电源。

调试器

USB

具有片上 ICE 电路的器件
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图2-2： 标准调试器系统—— ICE器件

2.3 目标板通信连接

2.3.1 标准通信目标板连接

使用RJ-11连接器，通过模块化接口（6芯）电缆将MPLAB ICD 4在线调试器连接到目
标器件。连接器的引脚编号显示在目标PCB的底部，如图2-3所示。 

图2-3： 目标板上的标准连接

目标板

转换插座

器件 -ICE

处理器扩展包

标准
适配器调试头

器件 -ICE

ICD 调试头

或

为目标板或调试器供电的外部电源。

USB

调试器

USB

注： 调试器和目标板上的电缆连接互为镜像，即电缆一端上的引脚 1 连接到电缆
另一端的引脚6（见第B.5.3.3节“模块化电缆规范”）。

1

2

3

4

5

6

目标
连接器

目标

底部
PCBVPP/MCLR

Vss

PGC
VDD

PGD
保留
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2.3.2 目标板连接电路

图2-4显示了MPLAB ICD 4在线调试器与目标板上连接器的互连情况。该图还显示了从
连接器到目标PCB上器件的连线。建议在VPP/MCLR线与VDD之间接一个上拉电阻（通
常约为50 kΩ），这样可将线路置为低电平以复位器件。

图2-4： 目标电路的标准连接

2.3.3 目标供电

有两种方法可从外部为目标供电：

• 通过目标板从外部供电

• 通过调试器从外部供电

在下面的说明中，将只谈到与关键调试器操作相关而且有效的三根线：引脚1（VPP/
MCLR）、引脚5（PGC）和引脚4（PGD）。图2-4中显示了引脚2（VDD）和引脚3
（VSS）是出于完整性考虑。

为目标器件供电时，请确保目标板不会暴露在高于器件VDD额定值的电压下。 

不得超过器件VDD的绝对最大额定值。器件在最大额定值条件下工作一段时间，其可靠
性可能受到影响。 

我们建议不要使器件工作在超过器件数据手册规范标示的参数范围的条件下。

有关所需的器件电压大小和最大额定值，请参见器件数据手册。

2.3.3.1 通过目标板从外部供电

为目标器件供电的推荐方法是将外部电源直接连接到目标板。在该配置中，调试器通
过检测目标VDD来实现目标低电压操作的电平转换。如果调试器在其VDD线（接口连接
器的引脚2）上未检测到电压，则它将无法工作。

2.3.3.2 通过调试器从外部供电

为目标器件供电的替代方法是将外部电源直接连接到MPLAB ICD 4。请注意，还必须
通过MPLAB X IDE选择通过MPLAB ICD 4调试器供电。

VDD

VPP/MCLR

PGC

PGD

VSSAVDD

AVSS

2

1

5

4

3

用户复位

接口
连接器

应用
PCB

器件 50 kΩ
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不是所有的器件都有AVDD和AVSS线，但是如果目标器件上有这两根线，为了调试器能
够正常工作，必须将它们连接到适当的电平。它们不能处于悬空状态。

通常情况下，建议将所有VDD/AVDD和VSS/AVSS线连接到适当的电平。此外，应将具
有VCAP线器件（例如PIC18FXXJ MCU）的VCAP线连接到适当的电容或电平。

2.3.4 阻止调试器正常工作的电路

图2-5给出了调试器的三根有效线上会阻止MPLAB ICD 4在线调试器系统正常工作的
一些元件。

图2-5： 不正确的电路元件

确切地说，必须遵循以下准则：

• 请勿在PGC/PGD上使用上拉——它们可能会破坏电压值。

• 请勿在PGC/PGD上使用电容——它们将阻止数据线和时钟线在编程和调试通信期
间快速变化并且会延长编程时间。

• 请勿在MCLR上使用电容——它们将阻止VPP快速变化。通常一个简单的上拉电阻
就已足够。

• 请勿在PGC/PGD上使用二极管——它们将阻止调试器和目标器件之间进行双向
通信。

2.4 调试

使用MPLAB ICD 4在线调试器系统作为调试器有两个步骤。第一步要求将应用程序烧
写到目标器件中（MPLAB ICD 4可用于此过程）。第二步是使用目标闪存器件的内部
在线调试硬件来运行和测试应用程序。这两步与MPLAB X IDE操作直接相关：

1. 将代码烧写到目标器件并激活具体的调试功能。

2. 使用调试器设置断点并运行。

注： 相互连接非常简单。对于遇到的任何问题，通常都是由这些关键线路上干扰
MPLAB ICD 4在线调试器系统操作的其他连接或元件引起的，如下节所述。

不允许！

不允许！

不允许！

不允许！
VPP/MCLR

PGC

PGD

1

5

4

接口
连接器

注： 有关调试的信息，请参见MPLAB X IDE在线帮助。
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如果目标器件不能被正确编程，MPLAB ICD 4在线调试器将无法进行调试。

下面给出了MPLAB ICD 4在线调试器的部分内部接口电路的简化图。 

图2-6： 正确的编程连接 

编程时，目标器件不需要时钟，但必须为其提供电源。编程时，调试器将编程电压置
于VPP/MCLR上，通过PGC发送时钟脉冲，通过PGD发送串行数据。要校验器件是否
已被正确编程，可以向PGC发送时钟，并通过PGD读回数据。此序列可确认调试器和
器件是否正确通信。

2.5 调试要求

要使用MPLAB ICD 4在线调试器系统进行调试（设置断点和查看寄存器等），以下关
键因素必须正确：

• 调试器必须连接到计算机。它必须由计算机通过USB电缆供电，并且必须通过USB
电缆与MPLAB X IDE软件通信。有关详细信息，请参见第3.3节“调试教程”。

• 目标器件必须通电且具有正常运行的振荡器。如果目标器件因任何原因无法运行，
MPLAB ICD 4在线调试器将无法进行调试。

• 目标器件必须正确编程其配置字。这些配置字使用MPLAB X IDE来设置。

- 振荡器配置位应对应于RC和XT等，具体取决于目标设计。

- 对于某些器件，看门狗定时器默认使能，需要禁止。

- 不要使能目标器件的代码保护功能。

- 不要使能目标器件的表读保护功能。

- 对于具有多个PGC/PGD对的某些器件，需要在器件的配置字设置中选择正确的
对。这一点仅针对调试，因为编程可通过任何PGC/PGD对工作。

满足了以上条件后，即可接着进行下列操作：

• 进入调试模式的操作序列

• 调试详细信息

+5V

编程电压

VPP/MCLR

PGC

PGD

1

5

4

内部电路

VSS

VDD
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2.5.1 进入调试模式的操作序列

假定满足调试要求，将MPLAB ICD 4在线调试器设置为MPLAB X IDE中的当前工具。
转到File>Project Properties（文件>项目属性），打开对话框，然后在“Hardware Tool”
（硬件工具）下单击 ICD 4。现在可以执行以下操作。

• 选择Debug>Debug Main Project（调试 > 调试主项目）时，应用程序代码将通过
ICSP协议编程到器件的存储器中，如本章开头所述。

• 一个小的“调试执行程序”将加载到目标器件的存储器中。由于某些架构要求调试
执行程序必须驻留在程序存储器中，因此应用程序不能使用此保留的空间。有些器
件为调试执行程序提供了专门的存储区。有关详细信息，请参见器件数据手册。

• 目标器件中的特殊“在线调试”寄存器通过MPLAB X IDE使能。这些寄存器允许调
试器激活调试执行程序。有关器件保留资源的更多信息，请参见第2.7节“调试器
使用的资源”。

• 目标器件在调试模式下运行。

2.5.2 调试详细信息

图2-7显示了准备好开始调试的MPLAB ICD 4在线调试器系统。

图2-7： 准备好开始调试的MPLAB® ICD 4调试器

为判断应用程序能否正确运行，可在程序代码中预先设置断点。当通过MPLAB X IDE
的用户界面设置断点时，断点的地址保存在目标器件的特殊内部调试寄存器中。PGC
和PGD上的命令直接传送到这些寄存器来设置断点地址。

程序
存储器

文件
寄存器

内部调试
寄存器

VPP/MCLR

PGC

PGD

1

5

4

执行程序
调试

 

目标器件

 才能使
必须运行

调试执行
程序正常
运行

 

VDD

调试执行程序
共用的硬件
堆栈

调试执行程序 

为调试执行 
程序保留的
 空间

MPLAB ICD 4
在线调试器

使用的空间
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接下来，通常在MPLAB X IDE中选择Debug>Debug Main Project功能。然后，调试器
通知调试执行程序运行。目标器件将从复位向量开始执行，直到程序计数器到达先前
存储在内部调试寄存器中的断点地址。

执行断点地址处的指令后，目标器件的在线调试机制会“启动”，并将器件的程序计
数器传递给调试执行程序（类似于中断），用户的应用程序将暂停执行。调试器通过
PGC和PGD与调试执行程序通信，获取断点状态信息，并将这些信息发送回MPLAB X
IDE。随后，MPLAB X IDE向调试器发送一系列查询，以获取关于目标器件的信息，
即文件寄存器内容和CPU状态。这些查询由调试执行程序执行。

调试执行程序像程序存储器中的应用程序一样运行。它使用堆栈中的某些地址单元存
储临时变量。如果器件没有运行，无论出于何种原因（没有振荡器、电源连接故障和
目标板短路等），调试执行程序都将无法与MPLAB ICD 4 在线调试器通信，并且
MPLAB X IDE将发出一条错误消息。

设置断点的另一种方法是选择Debug>Pause（调试 > 暂停）。这会翻转PGC和PGD
线，从而使目标器件的在线调试机制将程序计数器从程序存储器中的用户代码切换到
调试执行程序。同样，目标应用程序暂停，MPLAB X IDE通过调试器与调试执行程序
的通信来查询目标器件的状态。

2.6 编程

在MPLAB X IDE中，使用MPLAB ICD 4作为编程器来编程非-ICE/-ICD器件，即不在调
试头板上的器件。将MPLAB ICD 4调试器设置为当前工具（单击导航窗口中的Debug
Tool ICD 4（调试工具 ICD 4），接着从主菜单中选择File>Project Properties，打开对
话框，然后在“Hardware Tool”下单击 ICD 4）以执行这些操作：

• 选择Run Main Project（运行主项目）图标（见下图）后，应用程序代码将通过ICSP
协议编程到器件的存储器中。编程时不需要时钟，可以编程所有的处理器模式，包
括代码保护、使能看门狗定时器和表读保护。

图2-8： RUN MAIN PROJECT图标

• 对于某些目标器件，可以将一个小的“编程执行程序”载入程序存储器的高地址区
域中。 

• 目标器件中的特殊“在线调试”寄存器以及所有调试功能均通过MPLAB X IDE使
能。这意味着不能设置断点，不能查看或更改寄存器内容。

• 目标器件运行在发布模式下。作为编程器，调试器只能通过翻转MCLR线来复位和
启动目标器件。

注： 有关编程的信息，请参见MPLAB X IDE在线帮助。
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2.7 调试器使用的资源

有关器件中调试器所用资源的完整列表，请参见MPLAB X IDE中用于MPLAB ICD 4在
线调试器的在线帮助文件。在MPLAB X IDE的“Learn & Discover”（学习和发现）页面
中，单击Users Guide & Release Notes（用户指南和版本说明），然后单击“Reserved
Resources for MPLAB ICD 4”（为MPLAB ICD 4保留的资源）链接。
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注：
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第3章 调试器使用

3.1 简介

以下主题介绍了如何安装和使用MPLAB ICD 4在线调试器。

• 安装和设置

• 调试教程

• 调试 /编程快速参考

• 调试器限制

• 连接目标板

• 设置目标板

• 启动和停止调试

• 查看处理器存储器和文件

• 断点和跑表

3.2 安装和设置

有关安装 IDE并设置调试器以与 IDE配合使用的详细信息，请参见“Getting Started with
MPLAB X IDE”帮助文件。 

概述：

1. 安装MPLAB X IDE。
MPLAB X IDE在线帮助中提供了教程主题，可从主菜单栏Help>Tool Help
Contents>MPLAB X IDE Help>Tutorial（帮助>工具帮助内容> MPLAB X IDE帮
助>教程）中访问这些主题。

2. 将MPLAB ICD 4连接到计算机并允许安装默认USB驱动程序。有关目标连接的更
多信息，请参见第2章“工作原理”。

3. 选择开发时要使用的语言工具套件 /编译器，并将其安装在计算机上。

4. 启动MPLAB X IDE并打开在线帮助（Help>Tool Help Contents>MPLAB X IDE
Help/Tutorial（帮助>工具帮助内容>MPLAB X IDE帮助 /教程）），以获取有关
创建和设置新项目以及运行和调试代码的详细说明。

注意事项：

1. 每个调试器都包含一个惟一标识符，首次安装时，无论使用哪个计算机USB端口
都会由操作系统识别。

2. MPLAB X IDE操作在运行（运行或调试运行）时连接至硬件工具。要始终连接到
硬件工具，请参见Tools>Options（工具>选项）中的Embedded（已安装工具）
按钮，然后在Generic Settings（通用设置）选项卡中选中“Maintain active
connection to hardware tool”（保持与硬件工具的有效连接）复选框。

3. 配置位只能在Configuration Bits（配置位）窗口中查看。要在代码中设置配置位，
选择Window>Target Memory Views（窗口>目标存储器视图），然后从Memory
（存储器）下拉列表中选择“Configuration Bits”，从Format（格式）下拉列表
中选择“Read/Write”（读 /写）使能设置访问。

注： 调试器无法为目标板供电。必须使用外部电源（见第3.7.3节“为目标板
供电”）。
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3.3 调试教程

请参见标题为“Getting Started with MPLAB X IDE”的MPLAB X IDE帮助文件，并在
“Tutorial”（教程）中导航到“Running and Debugging Code”（运行和调试代码）。

3.4 调试 /编程快速参考

下表给出了将MPLAB ICD 4在线调试器用作调试或编程工具时的快速参考。

3.5 调试器限制

有关器件的调试器限制的完整列表，请参见MPLAB X IDE中的在线帮助文件（Help>
Tool Contents>Hardware Tool Reference>Limitations（帮助>工具内容>硬件工具参考>
限制））。

注： 目前不支持调试头。

表3-1： 调试与编程操作

项目 调试 编程

所需硬件 计算机和目标应用（Microchip演示板或您自己设计的电路板）

调试器、USB电缆和电源（如果需要）

带片上调试电路的器件或带特殊-ICE器件的调试头 器件（带或不带片上调试电路）

MPLAB X IDE选择 Project Properties，Hardware Tool选择PICkit 4

Debug Main Project图标 Make and Program Device（编译并
编程器件）图标

编程操作 将应用程序代码烧写到器件中。根据Project 
Properties对话框上的选择，这可以是程序存储器
的任何范围。此外，还有一个小的调试执行程序位
于程序存储器中，其他调试资源保留。

将应用程序代码烧写到器件中。根据
Project Properties对话框上的选择，
这可以是程序存储器的任何范围。

可用的调试功能 适用于器件的所有功能——断点等 N/A

序列号快速编程
（Serial Quick-Time 
Programming，
SQTP）

N/A 使用MPLAB IPE生成SQTP文件。 

命令行操作 使用MDB命令行实用程序，默认路径为：
C:\Program Files (x86)\
Microchip\MPLABX\v4.15.11\
mplab_platform\bin\mdb.bat

使用 IPECMD，默认路径为：
C:\Program Files (x86)\
Microchip\MPLABX\<vx.xx>\
mplab_platform\
mplab_ipe\ipecmd.exe。
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3.6 连接目标板

1. 如果尚未连接，请使用Mini-B USB电缆将调试器与计算机相连。

2. 使用通信电缆将调试器与目标板相连。

3. 将电源连接到目标板或调试器。

有关更多详细信息和图，请参见第2.2节“调试器与目标板之间的通信”。

图3-1： 直接为目标板供电 

图3-2： 通过调试器为目标板供电 

注： 在MPLAB X IDE中，您可以选择为目标板供电的电源。要通过MPLAB ICD 4
调试器为目标板供电，必须将电源连接到调试器。

Mini-B USB

3

来自电源 *

目标板

1

来自计算机

通信电缆

来自目标板
2

* 可选择 Microchip 电源（AC002014）

来自电源

3

Mini-B USB

目标板

1

来自计算机

通信电缆

来自目标板
2
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3.7 设置目标板

必须为要使用的目标器件类型设置目标板。

3.7.1 使用生产器件

对于生产器件，调试器可以直接连接到目标板。目标板上的器件必须有内置调试电路，
以便MPLAB ICD 4在线调试器用它进行调试。

目标板必须有一个连接器，以适合为调试器所选的通信方式。有关连接信息，请参见
第2.2节“调试器与目标板之间的通信”。

3.7.2 使用 ICE器件

对于 ICE器件，需要 ICE调试头板。调试头板包含仿真特定器件或器件系列所必需的
硬件。有关 ICE调试头的更多信息，请参见《处理器扩展包（PEP）和调试头规范》
（DS50001292W_CN）。

将转换插座与ICE调试头一起使用，以将调试头连接到目标板。提供了多种类型的转换
插座，以允许通用的调试头能够与某个受支持的表面贴装类型相连。有关转换插座的
更多信息，请参见“Transition Socket Specification”（DS50001194）。

对于不同的调试头以及不同的处理器扩展包，调试头板布线有所不同。有关连接信
息，请参见第2.2节“调试器与目标板之间的通信”。

3.7.3 为目标板供电

有两种配置可为MPLAB ICD 4和目标板供电：

• 目标板通过外部电源供电。

• 目标板通过MPLAB ICD 4供电，MPLAB ICD 4连接到外部电源。

外部电源（部件编号AC002014）可从Microchip Direct购买，网址为：
http://www.microchipdirect.com。

如果尚未执行此操作，请使用适当的电缆将MPLAB ICD 4连接到目标板（见第3.6节
“连接目标板”）。然后为目标板供电。 

注： 目前不支持调试头。

http://www.microchipdirect.com
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3.8 启动和停止调试

要在MPLAB X IDE中调试应用程序，必须创建一个包含源代码的项目，以便按照如下
所述编译代码、将代码烧写到器件中并执行：

• 选择Debug>Debug Main Project或从Run（运行）工具栏选择 以运行代码。

• 选择Debug>Pause或从Debug（调试）工具栏中选择 以暂停代码。

• 选择Debug>Continue（调试>继续）或从Debug工具栏中选择 以再次运行代码。

• 选择Debug>Step Into（调试>单步进入）或从Debug工具栏中选择 以单步执行
代码。注意不要单步进入Sleep指令，否则必须执行处理器复位以恢复仿真。

• 从Debug工具栏中选择Debug>Step Over（调试>单步跳过）以单步跳过某一行
代码。

• 选择Debug>Finish Debugger Session（调试>完成调试器会话）或从Debug工具
栏中选择 以结束代码执行。

• 从Debug工具栏中选择择Debug>Reset（调试>复位）以对代码执行处理器复位。
根据器件的不同，可能有其他复位（如POR/BOR、MCLR和系统复位）。有关更
多信息，请参见产品数据手册。

3.9 查看处理器存储器和文件

MPLAB X IDE提供了多个窗口来查看调试信息和存储器信息，可在Window（窗口）菜
单中进行选择。有关使用这些窗口的更多信息，请参见MPLAB X IDE在线帮助。

• Window>Target Memory Views ——查看器件存储器中的数据（数据存储器）和代
码（执行存储器）。其他存储器也可以按器件的定义进行查看，包括外设、配置
位、CPU寄存器、外部EBI存储器、外部SQI存储器和用户 ID存储器等。

• Window>Debugging（窗口>调试）——查看调试信息。从变量、观察、调用堆栈、
断点、跑表等中进行选择。

要查看源代码，在Projects（项目）窗口中找到要查看的源代码文件并双击以在Files
（文件）窗口中打开。该窗口中的代码根据所选处理器和编译工具采用不同颜色标识。
要更改颜色标识的样式，在Tools>Options的Fonts & Colors（字体和颜色）中，选择
Syntax（语法）选项卡。

3.10 断点和跑表

使用断点在代码中的指定行处暂停代码执行。使用跑表和断点对代码执行进行计时。

• 断点资源

• 硬件或软件断点选择

• 断点和跑表的使用

3.10.1 断点资源

对于16位器件，断点、数据捕捉和运行时观察使用相同的资源。因此，可用的断点数
实际上是可用的断点和触发的总数。

注： 有关菜单选项图标的信息，请参见MPLAB X IDE帮助。
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对于32位器件，断点使用的资源与数据捕捉和运行时观察不同。因此，可用的断点数
与可用的触发数无关。

可用和 /或已用的硬件和软件断点数在Dashboard（仪表板）（Window>Dashboard
（窗口>仪表板））窗口中显示。有关该功能的更多信息，请参见MPLAB X IDE在线帮
助。并非所有器件都有软件断点。

有关断点操作的限制（包括每个器件硬件断点的常规数目以及硬件断点skidding
量），请参见MPLAB X IDE的在线帮助文件了解有关调试器限制的信息（Help>Help
Contents>Hardware Tool Reference>Limitaitons - Emulators and Debuggers（帮助>
帮助内容>硬件工具参考>限制——仿真器和调试器））。

3.10.2 硬件或软件断点选择

要选择硬件或软件断点：

1. 在Projects窗口中选择项目。然后，选择File>Project Properties，或右键单击项
目并选择“Properties”。

2. 在Project Properties对话框的“Categories”（类别）下，选择“ICD4”。

3. 在“Option Categories”（选项类别）下，选择“Debug Options”（调试选项）。

4. 选中“Use software breakpoints”（使用软件断点）以使用软件断点。取消选中
以使用硬件断点。

为帮助您确定使用哪类断点（硬件或软件），下表对每种断点的特性进行了比较。

表3-2： 硬件断点与软件断点

3.10.3 断点和跑表的使用

断点用于暂停代码的执行。要确定两个断点之间的时间，请使用跑表。

有关如何设置及使用断点和跑表的信息，请参见MPLAB X IDE在线帮助。

注： 使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种
方式使用过的器件用作生产器件。

特性 硬件断点 软件断点

断点数 有限 无限

断点写入到* 内部调试寄存器 闪存程序存储器

断点应用于** 程序存储器 /数据存储器 仅程序存储器

设置断点的时间 最短 取决于振荡器速度、编程闪存
存储器的时间以及页大小

断点skidding 大多数器件。有关详细信息，请参
见在线帮助中的Limitations（限制）
部分。

否

*器件中写入断点信息的位置。
**适用于断点的器件功能类型。这是设置断点的位置。
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注：



 2018 Microchip Technology Inc.  DS50002596C_CN 第35页

MPLAB® ICD 4用户指南 

第4章 故障诊断首要步骤

4.1 简介

如果MPLAB ICD 4在线调试器在工作过程中出现问题，请从此处开始故障诊断。

• 要首先回答的一些问题

• 无法调试的首要原因

• 需要考虑的其他事项

4.2 要首先回答的一些问题

1. 使用的是哪款器件？要支持新的器件，通常需要将MPLAB X IDE升级到较新的
版本。

2. 您使用的是Microchip的演示板还是您自己设计的电路板？
您是否遵循了用于通信连接的电阻 /电容的准则？请参见第2章“工作原理”。

3. 您是否已为目标板供电？必须将外部电源连接到目标板（首选）或调试器。 

4. 在安装过程中您是否使用了USB集线器？它是否已上电？如果仍有问题，请尝试
不使用集线器来连接调试器（将调试器直接插入计算机）。

5. 您是否使用了随调试器一起提供的标准通信电缆（RJ-11）？如果您使用了更长
的电缆，则可能导致通信错误。

6. 您是否使用了随调试器一起提供的USB电缆？其他USB电缆可能质量差、过长或
不支持USB通信。

4.3 无法调试的首要原因

1. 振荡器不工作。检查与振荡器有关的配置位设置。如果使用的是外部振荡器，请
尝试使用内部振荡器。如果使用的是内部PLL，请确保PLL的设置正确。

2. 目标板未上电。检查电源电缆连接。

3. VDD电压不正确。VDD电压超出该器件规范。更多详细信息，请参见器件编程
规范。

4. 断开物理连接。调试器已断开与计算机和 /或目标板的物理连接。检查通信电缆的
连接。

5. 通信中断。调试器与PC的通信已中断。在MPLAB X IDE中重新连接调试器。

6. 器件未安装。器件未正确安装在目标板上。如果调试器连接正确并且目标板已通
电，但器件不存在或未完全插入，则可能会收到以下消息：
Target Device ID (0x0) does not match expected Device ID (0x%x)
（目标器件 ID（0x0）与预期器件 ID（0x%x）不匹配），其中%x为预期器件
ID。

7. 器件受到代码保护。检查配置位设置，看是否使能了代码保护。
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8. 无器件调试电路。生产器件可能没有调试功能。请使用调试头代替。（请参见“推
荐读物”中的《处理器扩展包（PEP）和调试头规范》（DS50001292W_CN）。）

9. 应用程序代码损坏。目标应用程序损坏或包含错误。尝试重新编译和重新编程目
标应用程序。然后对目标启动上电复位。

10. 引脚编程不正确。没有在配置位中正确编程PGC/PGD引脚对（对于带多个PGC/
PGD引脚对的器件）。

11. 需要额外的设置。其他配置设置干扰调试。任何阻止目标执行代码的配置设置同
样会阻止仿真器将代码置于调试模式。

12. 欠压电压不正确。欠压检测电压大于工作电压VDD。这意味着器件处于复位状态，
不能调试。

13. 连接不正确。请参见第2章“工作原理”中的准则了解正确的通信连接。

14. 请求无效。调试器无法始终执行请求的操作。例如，如果目标应用程序当前正在
运行，则调试器无法设置断点。

4.4 需要考虑的其他事项

4.4.1 通用

1. 使用ICD测试接口模块验证调试器是否正常工作（第B.6节“ICD测试接口模
块”）。

2. 通常，编程可能会出现问题。作为测试，使用 图标切换为运行模式，然后向
目标烧写一个尽可能简单的应用程序（例如，使LED闪烁的程序）。如果程序没
有运行，则说明目标设置存在错误。

3. 目标器件很可能因某种原因（如过流）遭到损坏。开发环境明显对元器件不利。
请考虑尝试另一个目标板。

4. 查看调试器设置以确保应用设置正确（有关更多信息，请参见第2章“工作
原理”）。

5. 对于您的电路而言，您的编程速度可能设置得过快。在MPLAB X IDE中，转至
File>Project Properties，在Categories中选择ICD4，然后在Option categories中
选择Program Options（编程选项），从相应下拉菜单中为Program Speed（编
程速度）选择一个较慢的速度。默认设置为Normal（正常），见下图。

图4-1： 编程速度选项
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6. 在某些情况下，调试器可能无法正常运行，可能需要下载固件或需要重新编程调
试器。请参见以下部分以确定其他操作。 

4.4.2 如何调用自举模式

如果MPLAB X IDE或MPLAB IPE无法与调试器通信，则可能需要强制调试器进入自举
模式（下载新固件）。一些可能的原因如下： 

• 第4.4.1节“通用”中的步骤1-5没有更正调试器问题。

• MPLAB X IDE或MPLAB IPE无法与调试器通信（例如，LED在紫色和蓝色之间不
断交替变化）。 

• MPLAB X IDE的Output（输出）窗口在应用程序版本号旁边显示星号（*），说明
调试器的固件不是最新版本。

如果Project Properties Firmware（项目属性固件）选项未选中“Use Latest Firmware”
（使用最新固件）复选框，而MPLAB X IDE有新固件版本可用，则会发生这种情况。

在这种情况下，请选中“Use Latest Firmware”复选框，然后单击MPLAB X IDE
仪表板显示中的“Refresh Debug Tool Status”（刷新调试工具状态）图标 。
如果应用程序版本号旁边仍有星号，或者未解决调试器问题，请继续执行以下步骤
以实现自举模式。

有关LED模式和自举程序错误的更多信息，请参见第B.4.2节“指示灯（LED）”。

执行以下步骤以强制调试器进入自举模式：

1. 将Mini-B USB电缆从调试器断开。

2. 按照以下两种方法之一来形成短路：

首选方法：如果您使用推荐的Microchip 9V电源（AC002014），请将其插入
MPLAB ICD 4，但需要从墙壁或电源接线板上拔下电源线。

或

备选方法：如果未使用推荐的电源，请确保调试器未连接电源。然后，将一把小
金属螺丝刀插入9V母头桶形连接器，使其接触中心引脚和插孔底部的金属片。
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图4-2： 形成短路的备选方法

3. 将Mini-B USB电缆插回调试器。

4. 一旦两个 LED 快速闪烁，请立即从调试器上拔下电源线或拔出螺丝刀（1 秒钟
内）。如果LED呈紫色稳定点亮状态，请继续执行下一步。如果LED为蓝色，则
表示您执行操作的速度不够快，必须从步骤1开始重复此过程。 

5. 尝试重新与MPLAB X IDE或MPLAB IPE建立通信。如果成功，将自动下载最新
固件，调试器将进行内置自检。完成后，LED呈蓝色稳定点亮状态，调试器准备
好开始工作。

4.4.3 如何使用硬件工具紧急自举固件恢复实用程序

在极少数情况下，可能需要强制调试器进入恢复自举模式（重新编程）；例如，如果
在调试器连接到计算机时发生以下任何情况：

• 调试器没有点亮任何LED。

• LED为青色。 

• 第4.4.2节“如何调用自举模式”中描述的步骤不成功。

必须使用MPLAB X IDE V4.15或更高版本才能使用紧急恢复实用程序。

警告

仅使用此实用程序将硬件工具自举固件恢复为出厂状态。
仅在硬件工具不能在任何计算机上运行时使用。
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请严格遵循MPLAB X IDE中主菜单选项Debug>Hardware Tool Emergency Boot Firmware
Recovery（调试>硬件工具紧急启动固件恢复）下的说明进行操作。 

图4-3： 选择紧急实用程序

如果该过程成功，则恢复向导将显示成功画面。MPLAB ICD 4现在可以运行，并且能够
与MPLAB X IDE通信。
如果该过程失败，请再次尝试。如果第二次仍然失败，请通过
http://support.microchip.com与Microchip技术支持联系。

http://support.microchip.com
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第5章 常见问题解答（FAQ）

5.1 简介

本章提供有关MPLAB ICD 4在线调试器系统的常见问题的解答。

• 工作原理

• 出现的问题

5.2 工作原理

• 芯片中的什么组件允许其与MPLAB ICD 4在线调试器通信？

MPLAB ICD 4在线调试器可通过 ICSP接口与闪存芯片通信。它使用位于测试存储
区中的调试执行程序。对于传统8位器件，调试执行程序位于程序存储器中。

• 必须运行调试执行程序对处理器吞吐量会有什么影响？

运行模式下，调试执行程序并不运行，因此在运行代码时不会降低吞吐量，即调试
器不会占用目标器件的任何周期。

• MPLAB X IDE与MPLAB ICD 4在线调试器如何接口来实现比旧版调试器更多的
功能？

MPLAB ICD 4在线调试器通过位于测试存储区中的调试执行程序进行通信。此调
试执行程序经过简化，能够实现更高的通信效率。调试器包含FPGA、大型SRAM
缓冲区（1Mx8）和高速USB接口。程序存储器映像下载并包含到SRAM中，从而
加快编程速度。与器件在线调试器模块接口时，调试器中的FPGA用作加速器。

• 在传统调试器上，数据必须移出到总线上才能对该数据执行复杂触发。MPLAB
ICD 4在线调试器上是否也需要这样？例如，是否可以根据变为高电平的标志执行
暂停操作？

传统调试器使用一个特殊的调试器芯片（-ME）进行监视。MPLAB ICD 4在线调试
器没有-ME，因此没有要在外部监视的总线。MPLAB ICD 4在线调试器采用调试引
擎的内置断点电路而不是外部断点，因此总线和断点逻辑在器件内部进行监视。

• MPLAB ICD 4在线调试器是否具有复杂断点？

有。您可以根据数据存储单元中的值来实现中断。如果在中断前有多个事件发生，
还可以设置顺序断点序列。但只能设置两个序列。此外，还可以设置AND条件以
及执行PASS计数。



MPLAB® ICD 4用户指南 

 DS50002596C_CN 第42页  2018 Microchip Technology Inc.

• 标准电缆存在哪些限制？

标准 ICSP-RJ11电缆的最大时钟频率约为15 MHz。无论CPU时钟速率如何，调试
期间的器件查询都会以低于此速率的频率发生。

但是，某些高级功能与CPU总线周期同步（如插装跟踪和数据捕捉）。

在数据捕捉期间以及CPU以最高速度（例如40 MIPS）运行时，通过电缆的实际时
钟速率将超过15 MHz。在这些情况下，跟踪和数据捕捉无法可靠运行，并且无法
使用 ICSP-RJ11电缆。

• 这是否会降低程序的运行速度？

MPLAB ICD 4在线调试器不占用任何周期。数据输出由芯片中的状态机执行。

• 可以调试以任何速度运行的dsPIC DSC吗？

MPLAB ICD 4能够以器件数据手册中指定的任何器件速度进行调试。

5.3 出现的问题

• 编程器件后，执行校验失败。这是编程问题吗？

如果选中Run Main Project图标（ ），则器件将在编程后立即自动运行。因
此，如果代码对闪存存储器进行了更改，校验可能会失败。要阻止代码在编程后立
即运行，请选择“Hold in Reset”（保持复位）。

• 我的计算机进入掉电 /休眠模式，并且现在调试器无法工作。这是怎么回事？

长时间使用调试器时（尤其是用作调试器时），请确保在计算机操作系统的“电源
选项”对话框窗口中禁止休眠模式。跳转到“休眠”选项卡，清除或取消选中“启
用休眠”复选框。这可确保保持所有USB子系统组件之间的所有通信。

• 我已将外设设置为暂停时不冻结，但它却突然发生冻结。这是怎么回事？

对于dsPIC30F/33F和PIC24F/H器件，外设控制寄存器中的一个保留位（通常为
bit 14或bit 5）由调试器用作冻结位。如果您对整个寄存器执行过写操作，那么您
可能改写了此位。（在调试模式下用户可访问此位。）

为避免上述问题，请只在应用程序中对想要更改的位执行写操作（通过BTS和
BTC），而不是对整个寄存器执行写操作（通过MOV）。

• 使用16位器件时，发生了意外复位。如何确定复位的原因？

考虑以下几个方面：

- 要确定复位源，请检查RCON寄存器。

- 在中断服务程序（Interrupt Service Routine，ISR）中处理陷阱 /中断。应包括
trap.c样式的代码，即

void __attribute__((__interrupt__)) _OscillatorFail(void);
          :
void __attribute__((__interrupt__)) _AltOscillatorFail(void);
          :
void __attribute__((__interrupt__)) _OscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
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        while (1);
   }
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;
        while (1);
   }
          :

- 使用ASSERT。如：ASSERT (IPL==7)
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第6章 错误消息

6.1 简介

MPLAB ICD 4在线调试器会产生各种不同的错误消息；其中一些错误消息比较特殊，
一些是仅供参考的信息类消息，而其他的都可以用常规纠正措施解决。通常，请阅
读错误消息下面的所有指示信息。如果无法解决问题或者无指示信息，请参见以下
章节。

• 错误消息类型

• 常规纠正措施

• 信息类消息

6.2 错误消息类型

6.2.1 安装损坏 /软件版本过期

Failed to download firmware（无法下载固件）

如果存在Hex文件：

• 重新连接并重试。

• 如果无法解决问题，则表明该文件可能已损坏。重新安装MPLAB X IDE。

如果不存在Hex文件：

• 重新安装MPLAB X IDE。

Unable to download debug executive（无法下载调试执行程序）

如果尝试调试时收到此错误：

1. 取消将调试器选作调试工具。

2. 关闭项目，然后关闭MPLAB X IDE。

3. 重新启动MPLAB X IDE，然后重新打开项目。

4. 重新选择调试器作为调试工具并再次尝试编程目标器件。

Unable to download program executive（无法下载编程执行程序）

如果尝试编程时收到此错误：

1. 取消将调试器选作编程器。

2. 关闭项目，然后关闭MPLAB X IDE。

3. 重新启动MPLAB X IDE，然后重新打开项目。

4. 重新选择调试器作为编程器并再次尝试编程目标器件。

如果这些措施无法解决问题，请参见第6.3.4节“安装损坏纠正措施”。
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6.2.2 调试失败错误

The target device is not ready for debugging. Please check your configuration bit
settings and program the device before proceeding.（目标器件未准备好调试。请
检查配置位设置并编程器件，然后继续。）

当您尚未编程器件就尝试运行时将收到此消息。如果在编程器件后尝试运行时收到此
消息，或者在编程器件后立即收到此消息：

器件受到代码保护。

您尝试进行操作（读、编程、空白检查或校验）的器件受到代码保护，即，无法读或修
改代码。检查配置位设置，看是否使能了代码保护（Windows>Target Memory Views>
Configuration Bits（窗口>目标存储器视图>配置位））。

要禁止代码保护，请根据器件数据手册，在代码或Configuration Bits窗口中置1或清零
相应的配置位。然后擦除并重新编程整个器件。

如果这些措施无法解决问题，请参见第6.3.2节“调试器与目标器件的通信错误纠正措
施”和第6.3.6节“调试失败纠正措施”。

6.2.3 其他错误

ICD 4 is busy. Please wait for the current operation to finish.（ICD 3忙。请等待当
前操作完成。）

如果在尝试取消将调试器选作调试器或编程器时收到此错误：

1. 等待——使调试器有时间完成任何应用程序任务。然后重新尝试取消选择调试器。

2. 选择 （结束调试器会话）来停止所有运行中的应用程序。然后重新尝试取消
选择调试器。

3. 将调试器从计算机上拔下。然后重新尝试取消选择调试器。

4. 关闭MPLAB X IDE。
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6.2.4 错误消息列表

表6-1： 按字母顺序排列的错误消息列表

AP_VER=算法插件版本

AREAS_TO_PROGRAM=将编程以下存储区：

AREAS_TO_READ=将读取以下存储区：

AREAS_TO_VERIFY=将校验以下存储区：

BLANK_CHECK_COMPLETE=空白检查完成，器件空白。

BLANK_CHECKING=正在检查空白 ...

BOOT_CONFIG_MEMORY=引导配置存储器

BOOT_VER=引导版本

BOOTFLASH=引导闪存

BP_CANT_B_DELETED_WHEN_RUNNING=目标运行时无法移除软件断点。所选断点将在下次目标暂停时移除。

CANT_CREATE_CONTROLLER=无法找到工具控制器类。

CANT_FIND_FILE=无法找到文件%s的位置。

CANT_OP_BELOW_LVPTHRESH=所选电压%f低于最小擦除电压%f。此电压下无法继续工作。

CANT_PRESERVE_PGM_MEM=无法保留程序存储器：无效范围起始地址 = %08x，结束地址 = %08x。

CANT_READ_REGISTERS=无法读取目标寄存器。

CANT_READ_SERIALNUM=无法读取器件序列号。

CANT_REMOVE_SWPS_BUSY=ICD 4当前繁忙，此时无法移除软件断点。 

CHECK_4_HIGH_VOLTAGE_VPP=CAUTION：检查MPLAB IDE中选择的器件（%s）是否与物理连接到调试工具的
器件相同。如果在连接3.3V器件时选择5V器件，则会导致调试器检查器件 ID时损坏器件。是否希望继续操作？

CHECK_PGM_SPEED=您已将编程速度设置为%s。电路板上的电路可能要求您减慢速度。请在工具属性中将设置更
改为“低”并再次尝试操作。

COMM_PROTOCOL_ERROR=调试工具已出现通信错误。工具将复位且应尽快重新枚举。

COMMAND_TIME_OUT=ICD 4超时等待命令%02x的响应。

CONFIGURATION=配置

CONIFGURATION_MEMORY=配置存储器

CONNECTION_FAILED=连接失败。

CORRUPTED_STREAMING_DATA=检测到无效的数据流。运行时观察或跟踪数据可能不再有效。建议重启您的调
试会话。

CPM_TO_TARGET_FAILED=ControlPointMediator.ToTarget()期间出现异常。

DATA_FLASH_MEMORY=数据闪存存储器

DATA_FLASH=数据闪存

DEBUG_INFO_PGM_FAILED=无法进入调试模式，因为调试信息编程失败。配置位的无效组合可能会导致这一问题。

DEBUG_READ_INFO=受目标振荡器速度的影响，在调试模式下读取器件可能会花费较长时间。缩小要读取的范围
（在 ICD 4项目属性下）可缓解这一情况。中止操作可用于在必要时终止读操作。 

DEVICE_ID_REVISION=器件 Id版本

DEVICE_ID=器件 Id

DEVID_MISMATCH=目标器件 ID（0x%x）是无效的器件 ID。请检查与目标器件的连接。
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DISCONNECT_WHILE_BUSY=工具在繁忙时断开。

EEDATA_MEMORY=EEData存储器

EEDATA=EEData

EMULATION_MEMORY_READ_WRITE_ERROR=尝试读 /写MPLAB®的仿真存储器时出现错误。地址=%08x

END=结束

ENSURE_SELF_TEST_READY=请确保RJ-11电缆连接到测试板后再继续。

ENSURE_SELF_TEST_READY=请确保RJ-11电缆连接到测试板后再继续。是否要继续？

ENV_ID_GROUP=器件标识

ERASE_COMPLETE=擦除成功

ERASING=擦除中 ...

FAILED_2_PGM_DEVICE=器件编程失败

FAILED_CREATING_COM=无法创建通信对象（RI4Com）。

FAILED_CREATING_DEBUGGER_MODULES=初始化失败：创建调试器模块失败

FAILED_ESTABLISHING_COMMUNICATION=无法建立工具通信

FAILED_GETTING_DBG_EXEC=尝试加载调试执行程序时出现问题。

FAILED_GETTING_DEVICE_INFO=初始化失败：检索器件数据库（.pic）信息时失败

FAILED_GETTING_EMU_INFO=初始化失败：仿真数据库信息获取失败

FAILED_GETTING_HEADER_INFO=初始化失败：调试头数据库信息获取失败

FAILED_GETTING_PGM_EXEC=尝试加载编程执行程序时出现错误

FAILED_GETTING_TEX=无法获取ToolExecMediator

FAILED_GETTING_TOOL_INFO=初始化失败：检索工具数据库（.ri4）信息时失败

FAILED_INITING_DATABASE=初始化失败：无法初始化工具数据库对象

FAILED_INITING_DEBUGHANDLER=初始化失败：无法初始化调试处理程序对象

FAILED_PARSING_FILE=固件文件解析失败：%s

FAILED_READING_EMULATION_REGS=仿真存储器读取失败。

FAILED_READING_MPLAB_MEMORY=无法读取%s存储器的%0x08至%0x08部分。

FAILED_SETTING_SHADOWS=无法正确设置影子寄存器。

FAILED_SETTING_XMIT_EVENTS=无法同步运行时数据信号量。

FAILED_STEPPING=对目标器件单步执行失败。

FAILED_TO_GET_DEVID=器件 ID获取失败。请确保目标器件已连接并再次尝试操作。

FAILED_TO_INIT_TOOL=ICD 4初始化失败

FAILED_UPDATING_BP=断点更新失败：\n文件：%s\n地址：%08x

FAILED_UPDATING_FIRMWARE=无法正确更新固件。

FILE_REGISTER=文件寄存器

FIRMWARE_DOWNLOAD_TIMEOUT=固件下载过程期间 ICD 4超时。

FLASH_DATA_MEMORY=闪存数据存储器

FLASH_DATA=闪存数据

FPGA_VER=FPGA版本

FRCINDEBUG_NEEDS_CLOCKSWITCHING=要在调试模式下使用FRC，必须使能时钟切换配置位设置。请使能时
钟切换并重试所请求的操作。

表6-1： 按字母顺序排列的错误消息列表（续）
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FW_DOESNT_SUPPORT_DYNBP=当前 ICD 4固件不支持为所选器件设置运行时断点。请下载固件版本
%02x.%02x.%02x或更高版本。

GOOD_ID_MISMATCH=目标器件 ID（0x%x）是有效器件 ID，但与选择的预期器件 ID（0x%x）不匹配。

HALTING=暂停中 ...

HIGH=高电平

HOLDMCLR_FAILED=保持复位失败。

IDS_SELF_TEST_BOARD_PASSED=ICD4正常工作。如果您的目标电路仍存在问题，请参见在线帮助中的“目标板
注意事项”部分。

IDS_ST_CLKREAD_ERR=测试接口PGC时钟线读取失败。

IDS_ST_CLKREAD_NO_TEST=测试接口PGC时钟线读取未经测试。

IDS_ST_CLKREAD_SUCCESS=测试接口PGC时钟线读取成功。

IDS_ST_CLKWRITE_ERR=测试接口PGC时钟线写入失败。请确保测试器连接正确。

IDS_ST_CLKWRITE_NO_TEST=测试接口PGC时钟线写入未经测试。

IDS_ST_CLKWRITE_SUCCESS=测试接口PGC时钟线写入成功。

IDS_ST_DATREAD_ERR=测试接口PGD数据线读取失败。

IDS_ST_DATREAD_NO_TEST=测试接口PGD数据线读取未经测试。

IDS_ST_DATREAD_SUCCESS=测试接口PGD数据线读取成功。

IDS_ST_DATWRITE_ERR=测试接口PGD数据线写入失败。

IDS_ST_DATWRITE_NO_TEST=测试接口PGD数据线写入未经测试。

IDS_ST_DATWRITE_SUCCESS=测试接口PGD数据线写入成功。

IDS_ST_LVP_ERR=测试接口LVP控制线故障。

IDS_ST_LVP_NO_TEST=测试接口LVP控制线未经测试。

IDS_ST_LVP_SUCCESS=测试接口LVP控制线测试成功。

IDS_ST_MCLR_ERR=测试接口MCLR电平故障。

IDS_ST_MCLR_NO_TEST=测试接口MCLR电平未经测试。

IDS_ST_MCLR_SUCCESS=测试接口MCLR电平测试成功。

IDS_TEST_NOT_COMPLETED=接口测试无法完成。请联系您当地的FAE/CAE对设备进行SAR。

INCOMPATIBLE_FW=REAL ICE固件与MPLAB X软件的当前版本不兼容。

INVALID_ADDRESS=操作无法继续，因为%s地址超出器件地址范围0x%08x-0x%08x。

MEM_RANGE_ERROR_BAD_END_ADDR=收到无效编程范围结束地址%s。请在调试工具的“Memories to Program”
（待编程存储器）属性页面上检查手动编程范围。

MEM_RANGE_ERROR_BAD_START_ADDR=收到无效编程范围起始地址%s。请在调试工具的“Memories to 
Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_END_LESSTHAN_START=收到无效编程范围：结束地址%s < 起始地址%s。请在调试工具
的“Memories to Program”属性页面上检查手动编程范围。

MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=收到无效编程范围：结束地址%s未对齐到适当的0x%x地址边
界。请在调试工具的“Memories to Program”（待编程存储器）属性页面上检查手动编程范围。

MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=收到无效编程范围：起始地址%s未对齐到适当的0x%x地址
边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

表6-1： 按字母顺序排列的错误消息列表（续）
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MEM_RANGE_ERROR_UNKNOWN=尝试验证用户输入的存储器范围时出现未知错误。

MEM_RANGE_ERROR_WRONG_DATABASE=无法在验证用户输入的存储器范围时访问数据对象。

MEM_RANGE_OUT_OF_BOUNDS=所选编程范围%s未在所选存储区的正确范围内。请在调试工具的“Memories to
Program”（待编程存储器）属性页面上检查手动编程范围。

MEM_RANGE_STRING_MALFORMED=在“Memories to Program”（待编程存储器）属性页面上输入的存储器范
围（%s）未采用正确格式。 

MISSING_BOOT_CONFIG_PARAMETER=无法在数据库中找到引导配置起始 /结束地址。

MUST_SET_LVPBIT_WITH_LVP=低电压编程功能需要在目标器件上使能LVP配置位。请使能此配置位并再次尝试
操作。

NEW_FIRMWARE=现在为目标器件下载新固件：%s

NMMR=NMMR

NO_DYNAMIC_BP_SUPPORT_AT_ALL=当前器件不支持在器件运行时设置断点。断点将在下次运行器件之前应用。 

NO_PGM_HANDLER=无法编程软件断点。编程处理程序尚未初始化。

NORMAL=正常

OP_FAILED_FROM_CP=所请求的操作失败，因为器件受到代码保护。

OpenIDE-Module-Name=ICD 4

OPERATION_NOT_SUPPORTED=所选器件不支持此操作

OUTPUTWIN_TITLE=ICD 4

PERIPHERAL=外设

POWER_ERROR_NO_9V=为工具设置配置以向目标供电，但未检测到9V电源插孔。请确保外部9V桶形插孔连接到
工具。

POWER_ERROR_NO_POWER_SRC=为目标板设置配置以自行供电，但VDD上未检测到任何电压。请确保您已为
目标供电并重试。

POWER_ERROR_POWER_SRC_CONFLICT=为工具设置配置以为目标供电，但VDD上已检测到电压。这是一种冲
突。请确保目标未在向工具提供电压并重试。

POWER_ERROR_SLOW_DISCHARGE=VDD上似乎有额外的电容，导致系统放电变慢和系统关闭。考虑最大程度
减小总电容负载或使用来自目标的电源来避免放电延时。

POWER_ERROR_UNKNOWN=发生未知电源错误。

POWER_ERROR_VDD_TOO_HIGH=所需VDD电压超出范围。它超出5.5V的最大电压。

POWER_ERROR_VDD_TOO_LOW=所需VDD电压超出范围。它低于1.5V的最小电压。

POWER_ERROR_VPP_TOO_HIGH=所需VPP电压超出范围。它超出14.2V的最大电压。

POWER_ERROR_VPP_TOO_LOW=所需VPP电压超出范围。它低于1.5V的最小电压。

PRESERVE_MEM_RANGE_ERROR_BAD_END_ADDR=收到无效保留范围结束地址%s。请在调试工具的“Memories
to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_BAD_START_ADDR=收到无效保留范围起始地址%s。请在调试工具的
“Memories to Program”属性页面上检查手动编程范围。

表6-1： 按字母顺序排列的错误消息列表（续）
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PRESERVE_MEM_RANGE_ERROR_END_LESSTHAN_START=收到无效保留范围：结束地址%s < 起始地址%s。
请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_ENDADDR_NOT_ALIGNED=收到无效保留范围：结束地址%s未对齐到适当
的0x%x地址边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_STARTADDR_NOT_ALIGNED=收到无效保留范围：起始地址%s未对齐到适
当的0x%x地址边界。请在调试工具的“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_ERROR_UNKNOWN=尝试验证用户输入的保留范围时发生未知错误。

PRESERVE_MEM_RANGE_ERROR_WRONG_DATABASE=无法在验证用户输入的存储器范围时访问数据对象。

PRESERVE_MEM_RANGE_MEM_NOT_SELECTED=您已选择保留一个存储区，但尚未选择编程该存储区。请在
调试工具的“Memories to Program”属性页面上检查保留范围，并确保保留的任何存储器也被指定为编程。

PRESERVE_MEM_RANGE_OUT_OF_BOUNDS=所选保留范围%s未在所选存储区的正确范围内。请在调试工具的
“Memories to Program”属性页面上检查手动编程范围。

PRESERVE_MEM_RANGE_STRING_MALFORMED=在“Memories to Program”属性页面上输入的保留存储器范
围（%s）未采用正确格式。 

PRESERVE_MEM_RANGE_WONT_BE_PROGRAMMED=在“Memories to Program”属性页面上输入的保留存储
器范围（%s）的部分或全部未处于所选存储器的指定编程范围（%s）内。请在调试工具的“Memories to Program”
属性页面上检查保留范围。

PROGRAM_COMPLETE=编程 /验证完成

PROGRAM_MEMORY=编程存储器

PROGRAM=编程

PROGRAMMING_DID_NOT_COMPLETE=编程未完成。

READ_COMPLETE=读取完成

READ_DID_NOT_COMPLETE=读取未完成。

RELEASEMCLR_FAILED=从复位释放失败。

REMOVING_SWBPS_COMPLETE=软件断点删除完成

REMOVING_SWBPS=正在删除软件断点 ...

RESET_FAILED=器件复位失败

RESETTING=正在复位 ...

RUN_INTERRUPT_THREAD_SYNCH_ERROR=发生内部运行错误。建议重启您的调试会话。您可以继续运行，但
某些运行时功能可能无法正常工作。

RUN_TARGET_FAILED=无法运行目标器件。

RUNNING=正在运行

SERIAL_NUM=序列号：\n

SETTING_SWBPS=正在设置软件断点 .......

STACK=堆栈

START_AND_END_ADDR=起始地址 = 0x%x，结束地址 = 0x%x

START=起始

TARGET_DETECTED=检测到目标电压

表6-1： 按字母顺序排列的错误消息列表（续）
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TARGET_FOUND=找到目标器件%s。

TARGET_HALTED=目标暂停

TARGET_NOT_READY_4_DEBUG=目标器件未准备好调试。请检查配置位设置并编程器件，然后继续。此故障最
常见的原因是振荡器和 /或PGC/PGD设置。

TARGET_VDD=目标VDD： 

TEST=测试

TOOL_IS_BUSY=ICD 4忙。请等待当前操作完成。

TOOL_VDD=VDD： 

TOOL_VPP=VPP： 

UNABLE_TO_OBTAIN_RESET_VECTOR=ICD 4无法检索复位向量地址。这表示未定义_reset符号，因此不会阻止
器件正常启动。

UNKNOWN_MEMTYPE=存储器类型未知

UNLOAD_WHILE_BUSY=ICD 4在繁忙时卸载。在再次使用 ICD 4之前，请拔下并重新连接USB电缆。

UPDATING_APP=正在更新固件应用程序 ...

UPDATING_BOOTLOADER=正在更新固件自举程序 ...

UPDATING_FPGA=正在更新固件FPGA...

USE_LVP_PROGRAMMING=注：如果要使用低电压编程对此器件进行编程，请在此对话框中选择Cancel（取消）。
然后转到项目属性的Real ICE节点，并选中Program Options选项类别窗格的Enable Low Voltage Programming（使
能低电压编程）复选框（低电压编程对调试操作无效）。

USERID_MEMORY=用户 Id存储器

USERID=用户 Id

VERIFY_COMPLETE=验证成功。

VERIFY_FAILED=验证失败

VERSIONS=版本

VOLTAGES=电压

WOULD_YOU_LIKE_TO_CONTINUE=是否要继续？

表6-1： 按字母顺序排列的错误消息列表（续）
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6.3 常规纠正措施

以下常规纠正措施可解决您遇到的问题：

• 读 /写错误纠正措施

• 调试器与目标器件的通信错误纠正措施

• 调试器与计算机的通信错误纠正措施

• 安装损坏纠正措施

• USB端口通信错误纠正措施

• 调试失败纠正措施

• 内部错误纠正措施

6.3.1 读 /写错误纠正措施

如果收到读或写错误：

1. 是否按下了Debug>Reset（调试>复位）？此操作可能产生读 /写错误。

2. 重试操作。该错误可能只发生一次。

3. 确保目标器件已上电并且器件的电压正确。有关所需器件电压，请参见器件数据
手册。

4. 确保调试器到目标器件的连接正确（PGC和PGD已连接）。

5. 对于写错误，确保在调试器的Program Options上选中“Erase all before Program”
（编程之前全部擦除）（见第A.3.3节“Program（编程）”）。

6. 确保所使用的电缆的长度正确。

6.3.2 调试器与目标器件的通信错误纠正措施

MPLAB ICD 4在线调试器与目标器件之间不能通信。

1. 选择Debug>Reset，然后重试操作。

2. 确保所使用的电缆的长度正确。

6.3.3 调试器与计算机的通信错误纠正措施

MPLAB ICD 4在线调试器与MPLAB X IDE之间不能通信。

1. 从计算机上拔下调试器，然后重新插入。

1. 重新连接调试器。

2. 重试操作。该错误可能只发生一次。

3. 所安装的MPLAB X IDE版本可能与MPLAB ICD 4在线调试器上加载的固件版本
不一致（请按照第6.3.4节“安装损坏纠正措施”中所述的步骤进行操作）。

4. 计算机USB端口可能存在问题（见第6.3.5节“USB端口通信错误纠正措施”）。

6.3.4 安装损坏纠正措施

该问题很可能是由于MPLAB X IDE的安装不完整或者损坏引起的。

1. 卸载计算机上所有的MPLAB X IDE版本。

2. 重新安装所需的MPLAB X IDE版本。

3. 如果问题依然存在，请联系Microchip支持部门。
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6.3.5 USB端口通信错误纠正措施

该问题很可能是由于通信端口故障或者不存在引起的。

1. 重新连接MPLAB ICD 4在线调试器。

2. 确保调试器已物理连接到计算机上适当的USB端口。

3. 确保在调试器选项中选择了适当的USB端口（见第A.3节“调试器选项选择”）。

4. 确保USB端口未被其他设备使用。

5. 如果使用USB集线器，请确保已将其上电。

6. 确保已加载USB驱动程序。

6.3.6 调试失败纠正措施

MPLAB ICD 4在线调试器无法执行调试操作。引发此错误的原因很多（见第4章“故障
诊断首要步骤”）。

6.3.7 内部错误纠正措施

内部错误难以预料并且不应该发生。它们用于Microchip内部开发。

最可能的原因是安装损坏（第6.3.4节“安装损坏纠正措施”）。

另一个可能的原因是系统资源不足。

1. 尝试重新启动系统以释放存储空间。

2. 确保硬盘上有适当的可用空间（而且不是过多的磁盘碎片）。

如果问题依然存在，请联系Microchip支持部门。

6.4 信息类消息

下面列出了MPLAB ICD 4在线调试器的信息类消息：

IDS_SELF_TEST_BOARD_PASSED: ICD4 is functioning properly. If you are
still having problems with your target circuit please check the Target Board
Considerations section of the online Help.（IDS_SELF_TEST_BOARD_PASSED：
ICD4 正在正常工作。如果您的目标电路仍存在问题，请查阅在线帮助的“Target
Board Considerations”（目标板注意事项）部分。）

请参见第B.7节“目标板注意事项”。
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注：
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附录A 调试器功能汇总

A.1 简介

下面列出了MPLAB ICD 4在线调试器功能的汇总。

• 调试器选择与切换

• 调试器选项选择

A.2 调试器选择与切换

使用Project Properties对话框可选择或切换项目的调试器。要进行切换，必须有多个
调试器与计算机相连。MPLAB X IDE将通过显示两个不同序列号来区分两个调试器。

要选择或更改项目使用的调试器：

1. 通过执行下列一项操作打开Project Properties对话框：

a) 单击Projects窗口中的项目名称并选择File>Project Properties。

或

b) 右键单击Projects窗口中的项目名称并选择“Properties”。

2. 在左侧的“Categories”下，展开“Conf:[default]”以显示 ICD4。

3. 在“Hardware Tool”下，找到“ICD 4”并单击序列号（Serial Number，SN）
来选择项目中使用的调试器，然后单击Apply（应用）。
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A.3 调试器选项选择

在Project Properties对话框中设置调试器选项。在“Categories”下单击 ICD4，显示
“Options for ICD4”（ICD4的选项）（见图A-1）。使用“Options categories”（选项
类别）下拉列表选择不同的选项。单击某个选项的名称可在下面的Option Description
（选项说明）框中查看其说明。单击选项名称的右侧可对其进行选择或更改。

图A-1： MPLAB ICD 4的选项

设置选项后，单击Apply或OK。还需单击MPLAB X IDE仪表板显示中的Refresh Debug
Tool状态图标 ，更新所做的任何更改。

可能的选项类别有：

• Memories to Program（要编程的存储器）

• Debug

• Program（编程）

• Freeze Peripherals（冻结外设）

• Power（电源）

• Secure Segment（安全段）

• Firmware（固件）

• Clock（时钟）

A.3.1 Memories to Program（要编程的存储器）

选择目标器件中要编程的存储器。表A-1显示了所有可能的选项，但只有可用于您所选
器件的选项将显示在MPLAB X IDE中。

注： 可用的选项类别以及这些类别中的选项取决于您选择的器件。 

注： 如果选择第A.3.3节“Program（编程）”中所述的“Erase All Before Program”
（编程前全部擦除），则编程前将擦除所有器件存储器。

表A-1： MEMORIES TO PROGRAM选项类别
Auto select memories 
and ranges（自动选择
存储器和范围）

Allow ICD 4 to Select Memories（允许 ICD 4选择存储器）——调
试器根据选择的器件和默认设置确定要编程的内容。
Manually select memories and ranges（手动选择存储器和范
围）——选择要编程的存储器的类型和范围（见下文）。
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A.3.2 Debug

如果此选项可用于项目所使用器件，则您可以选择使用软件断点。

Configuration Memory
（配置存储器）

选中时会将Configuration Memory包含在要编程的区域中。该选项
始终在调试模式下编程。

Boot Flash
（引导闪存）

选中时会将Boot Flash存储器包含在要编程的区域中。该选项始终
在调试模式下编程。

EEPROM 选中时会将EEPROM存储器包含在要编程的区域中。

ID 选中时可编程用户 ID。

Program Memory
（程序存储器）

选中时可编程下面指定的目标程序存储器范围。

Program Memory 
Range(s) (hex)
（程序存储器范围
（十六进制））

程序存储器中要编程、读取或校验的起始和结束十六进制地址范
围。范围必须用逗号隔开（例如0-ff，200-2ff）。范围必须对齐到
0x800地址边界。

注：地址范围不适用于擦除功能。擦除功能将擦除器件上的所有数据。

Preserve Program 
Memory
（保留程序存储器）

选中时不会编程下面指定的目标程序存储器范围。
确保代码不受代码保护。

Preserve Program 
Memory Range(s) (hex)
（保留程序存储器范围
（十六进制））

编程、读取或校验时目标程序存储器中要保留的起始和结束十六进
制地址范围。
此存储区从目标程序存储器中读取且覆盖现有的MPLAB X IDE存
储区。

Preserve Memory
（保留存储器）

选中时会将Memory保留用于重新编程，其中Memory为存储器类
型。类型包括：EEPROM存储器、ID存储器、引导闪存和辅助存
储器。
确保代码不受代码保护。

Preserve Memory 
Range(s) (hex)
（保留存储器范围
（十六进制））*

编程、读取或校验时目标Memory中要保留的起始和结束十六进制
地址范围。Memory为存储器类型，包括EEPROM存储器、ID存储
器、引导闪存和辅助存储器。
此存储区从目标程序存储器中读取且覆盖现有的MPLAB X IDE存
储区。
确保代码不受代码保护。

*如果您收到因不正确范围引起的编程错误，确保范围未超过可用 /剩余器件存储器的范围。

表A-2： DEBUG选项类别
Use Software 
Breakpoints
（使用软件断点）

选中时可使用软件断点。取消选中则使用硬件断点。请参见以下讨论，
了解哪种类型最适合您的应用。

表A-3： 软件断点与硬件断点

特性 软件断点 硬件断点

断点数 无限 有限

断点写入到 程序存储器 调试寄存器

设置断点的时间 取决于振荡器速度——可能需
要数分钟

最短

Skidding 否 是

表A-1： MEMORIES TO PROGRAM选项类别（续）
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A.3.3 Program（编程）

选择此选项类别时可在编程前擦除整个存储器或合并代码。

A.3.4 Freeze Peripherals（冻结外设）

从外设列表中选择程序暂停时冻结或不冻结的外设。可用外设取决于器件。

PIC12/16/18 MCU器件

要在暂停时冻结 /取消冻结所有器件外设，请选中 /取消选中“Freeze on Halt”（暂停
时冻结）复选框。如果这并未使所需外设暂停，请注意，某些外设没有暂停时冻结功
能，因而无法受调试器控制。

dsPIC30F/33F、PIC24F/H和PIC32MX器件

对于“Peripherals to Freeze on Halt”（暂停时冻结的外设）列表中的外设，选中某个
外设即可在暂停时将其冻结。取消选中外设可使其在程序暂停时运行。如果未在列表
中看到任何外设，则选中“All Other Peripherals”（所有其他外设）。如果这并未使
所需外设暂停，请注意，某些外设没有暂停时冻结功能，因而无法受调试器控制。

注：使用软件断点进行调试会影响器件的耐用性。因此，建议不要将以这种方式使用过的器件
用作生产器件。

表A-4： PROGRAM选项类别
Erase All Before Program 启用此选项将导致在从MPLAB X IDE编程数据之前擦除整个器

件。编程器件时，任何指定为保留的存储区都将在器件被擦除及
重新编程前读取。
除非编程新器件或已擦除的器件，否则都必须选中此复选框。若
未选中此复选框，将不对器件执行擦除操作并且程序代码将与器
件中已存在的代码合并。

Programming mode entry
（编程模式进入）

该选项指定MPLAB ICD 4用于将目标器件置于编程模式的方法。
对于低电压方法，VPP不会超过Vdd电源电压，而会对VPP使用
测试模式。对于高电压方法，将对VPP施加超过9V的电压。

LED Brightness Setting
（LED亮度设置）

选择从1（最暗）到10（最亮）的亮度等级。

PGC Configuration
（PGC配置）

此选项确定将应用于PGC线的电阻类型（下拉、上拉或无）。默
认为下拉。电阻值由下面的PGC电阻值选项决定。

PGC resistor value (kOhms)
（PGC电阻值（kΩ））

输入0-50的电阻值。默认值为4.7 kΩ。如果PGC配置设置为none
（无），则忽略该值。

PGD Configuration
（PGD配置）

选择none（无）、pull up（上拉）或pull down（下拉）。默认
为下拉。电阻值由下面的PGD电阻值选项决定。

PGD resistor value (kOhms)
（PGD电阻值（kΩ））

输入0-50的电阻值。默认值为4.7 kΩ。如果PGD配置设置为none
（无），则忽略该值。

Program Speed 选择调试器编程目标时所使用的速度，即Low（低速）、Normal
（正常速度）或High（高速）。默认为Normal。如果编程失败，
则使用低速可能会解决此问题。

表A-3： 软件断点与硬件断点
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要选择包括“All Other Peripherals”在内的所有外设，则单击Check All（全部选中）。
要取消选择包括“All Other Peripherals”在内的所有外设，则单击Uncheck All（全部
取消选中）。

A.3.5 Power（电源）

选择电源选项。

A.3.6 Secure Segment（安全段）

选择并加载调试器固件。

A.3.7 Firmware（固件）

选择并加载调试器固件。

A.3.8 Clock（时钟）

设置此选项可为所选器件使用快速内部RC时钟。

表A-5： POWER选项类别
Power Target Circuit 
from ICD 4（通过 ICD 4
为目标电路供电）

如果选中该选项，则将允许通过 ICD 4为目标电路供电。否则必须
使用外部电源（见第2.3.3节“目标供电”）。

Voltage Level
（电压大小）

如果选中“Power Target Circuit from ICD 4”复选框，则可选择调
试器提供的目标VDD（1.2V-5.5V）。

表A-6： SECURE SEGMENT选项类别
Segments to be 
Programmed
（要编程的段）

选择以下其中一种：Full Chip Programming（全芯片编程）（默认）；
Boot, Secure and General Segments（引导段、安全段和通用段）；
Secure and General Segments（安全段和通用段）或General Segment
Only（仅通用段）。

表A-7： FIRMWARE选项类别
Use Latest Firmware
（使用最新固件）

选中时可使用最新固件。取消选中时可选择固件版本。

Firmware File
（固件文件）

单击右侧文本框可搜索与调试器相关的固件文件（.jam）。

表A-8： CLOCK选项类别
Use FRC in Debug mode
（在调试模式下使用
FRC）（仅限dsPIC33F
和PIC24F/H器件）

调试时，使用器件内部快速RC（FRC）而不是为应用指定的振荡
器来提供时钟。这在应用时钟很慢时十分有用。
选中此复选框将使应用程序以低速运行，但以更快的FRC速度进行
调试。
更改此设置后重新编程。
注：在调试时，未冻结的外设将以FRC速度运行。



MPLAB® ICD 4用户指南 

 DS50002596C_CN 第62页  2018 Microchip Technology Inc.

注：
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附录B 硬件规范

B.1 简介

本章详述了MPLAB ICD 4在线调试器系统的硬件规范和电气规范。

B.2 目录

本章讨论了：

• USB端口 /通信

• MPLAB ICD 4在线调试器

• 标准通信硬件

• ICD测试接口模块

• 目标板注意事项

B.3 USB端口 /通信

MPLAB ICD 4在线调试器通过与USB 2.0版本兼容的USB端口与主机计算机连接。USB
连接器位于调试器的侧面。

系统能够通过USB接口重载固件。

可通过USB接口为调试器供电，但USB连接主要用于计算机和调试器之间的通信，无
法用于为目标供电。因此需要外部电源。根据USB规范，该调试器被归类为高功率系
统，需要通过USB提供300 mA的电流，才能使该调试器在所有工作模式（调试器 /编
程器）下正常工作。

电缆长度——在调试器工具包里随附了正常工作所需长度的计算机至调试器电缆。

供电的集线器——如果您想使用USB集线器，请确保它是自供电的。此外，计算机键
盘上的USB端口不能为调试器正常工作提供足够的功率。

计算机休眠 /掉电模式——禁止计算机上的休眠或其他节能模式，以确保与调试器的正
常USB通信。

注： MPLAB ICD 4在线调试器通过其USB连接供电。目标板则由自身电源供电。
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B.4 MPLAB ICD 4在线调试器

调试器包含一个内部主电路板、一个外部USB连接器、RJ-45连接器和一个9V DC电源
连接器。调试器外壳上有一个指示灯排，其中包括两个LED。

B.4.1 主电路板

主电路板具有以下特性：

• 一个使用ARM® Cortex®-M7内核的32位单片机。

• 一个USB速度达480 Mbps的USB 2.0接口。

• 一个用于常规系统控制并能够提高通信吞吐量的FPGA。

• 一个用于保存程序代码映像的SRAM。此映像用于编程板上闪存器件。

• 两个LED。

B.4.2 指示灯（LED）

MPLAB ICD 4调试器预期的启动序列为：

1. 紫色——稳定点亮约3秒钟。

2. 蓝色——当调试器运行上电自检时，闪烁约2秒钟。

3. 蓝色——稳定点亮。调试器就绪。

下表给出了用于读取指示灯的参考信息。

表B-1： LED和自举程序错误说明

左侧LED 右侧LED 说明

正常模式

蓝色 蓝色 电源已连接；调试器处于待机状态

橙色 蓝色 已选中Power target circuit from ICD 4（表A-5）

绿色 蓝色 未选中Power target circuit from ICD 4（表A-5）

紫色 紫色 自举程序正在运行

黄色 黄色 调试器忙

红色 红色 操作失败

紫色 紫色 快速闪烁表示强制调试器进入自举模式的时间窗口

自举程序错误

紫色 红色，慢速闪烁 访问调试器的串行EEPROM时出错

紫色 红色，快速闪烁 无法处理自举程序API命令

白色，快速闪烁 白色，快速闪烁 工具固件中出现运行时异常



硬件规范

 2018 Microchip Technology Inc.  DS50002596C_CN 第65页

B.5 标准通信硬件

要使调试器与目标板之间进行标准通信（第2.2节“调试器与目标板之间的通信”），
应使用具有RJ-11连接器的适配器。

要使调试头板使用此类型的通信，您需要一个针对器件的处理器包，它包括一个包含
所需 ICE/ICD器件的8引脚连接器调试头板和一个标准适配器板。

有关可用调试头板的更多信息，请参见《处理器扩展包（PEP）和调试头规范》
（DS50001292W_CN）。

图B-1： 通信连接

注： 较早的调试头板使用6引脚（RJ-11）连接器而非8引脚连接器，因此这些调
试头可以直接连接到调试器。

目标板

有关将RJ-11型电缆连接到RJ-45插座的信
息，请参见第B.5.1节“将RJ-11型电缆
连接到MPLAB ICD 4 在线调试器上的
RJ-45插座”。

有关将RJ-11型电缆连接到目
标板的信息，请参见第B.5.2节
“标准通信”。
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B.5.1 将RJ-11型电缆连接到MPLAB ICD 4在线调试器上的RJ-45插座

MPLAB ICD 4在线调试器具有用于与目标通信的RJ-45连接器。RJ-11型电缆与RJ-45
连接器的连接方式很简单，只需将RJ-11型电缆插入RJ-45连接器的中心即可。 

有关此连接的引脚排列，请参见图B-2。

图B-2： RJ-45插座与RJ-11连接器的引脚排列 

B.5.2 标准通信

调试器与目标处理器的主接口采用标准通信方式。它包含与高电压（VPP）线和VDD检测线
的连接，以及编程和连接目标器件所需的时钟和数据连接。

VPP高电压线可生成电压范围为0V至14V的可变电压，以满足特定仿真处理器的电压
要求。 

VDD检测连接从目标处理器汲取极少的电流。实际功率来自MPLAB ICD 4在线调试器
系统，因为VDD检测线仅用作参考来跟踪目标电压。VDD连接通过光电开关隔离。

时钟和数据连接是具有以下特性的接口：

• 时钟和数据信号为高阻模式（即使在未向MPLAB ICD 4在线调试器系统供电时也是
如此）。

• 时钟和数据信号不受因故障目标系统或不当连接引起的高电压的影响。

• 时钟和数据信号不受因故障目标系统中出现短路而引起的大电流的影响。

RJ-45 插座

1 
2 

3 
4 

5 
6 

7 
8

1 
2 

3 
4 

5 
6

RJ-11 连接器 / 电缆

引脚 RJ-45 功能 引脚 RJ-11

1 TMS JTAG测试模式选择

2 保留

3 PGC
（ICSPCLK）

标准通信时钟 /TCK
（JTAG测试时钟）

2 PGC
（ICSPCLK）

4 PGD
（ICSPDAT）

标准通信数据 /TDI
（JTAG测试数据输入）

3 PGD
（ICSPDAT）

5 GND 地 4 GND

6 VDD_TGT 目标板上的电源 5 VDD_TGT

7 VPP 电源 6 VPP

8 TDO JTAG测试数据输出
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图B-3： 6引脚标准引脚排列 

B.5.3 模块化电缆和连接器

标准通信使用模块化电缆连接调试器和目标应用。下面列出了有关此电缆及其连接器
的规范。

B.5.3.1 模块化连接器规范

• 制造商，部件编号—— AMP Incorporated，555165-1

• 代理商，部件编号—— Digi-Key，A9031ND

下表显示了某个应用中的模块化连接器引脚与单片机引脚的对应关系。这种配置提供
了全部的在线调试器功能。

图B-4： 目标板的模块化连接器引脚排列

B.5.3.2 模块化插头规范

• 制造商，部件编号—— AMP Incorporated，5-554710-3

• 代理商，部件编号—— Digi-Key，A9117ND

表B-2： 电气逻辑表

逻辑输入 VIH = VDD x 0.7V（最小值）

VIL = VDD x 0.3V（最大值）

逻辑输出 VDD = 5V VDD = 3V VDD = 2.3V VDD = 1.65V

VOH = 3.8V
（最小值）

VOH = 2.4V
（最小值）

VOH = 1.9V
（最小值）

VOH = 1.2V
（最小值）

VOL = 0.55V
（最大值）

VOL = 0.55V
（最大值）

VOL = 0.3V
（最大值）

VOL = 0.45V
（最大值）

1

2

3

4

5

6

引脚 名称 功能

1 VPP 电源

2 VDD_TGT 目标板上的电源

3 GND 地

4 PGD（ICSPDAT） 标准通信数据

5 PGC（ICSPCLK） 标准通信时钟

6 - 保留

目标板

标准插座

的底部

模块化连接器引脚 单片机引脚

6 保留

5 RB6

4 RB7

3 地

2 目标VDD

1 VPP

1
6

目标板上模块化连接器引脚排列

的底视图

1 6

目标板上模块化连接器

的正视图
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B.5.3.3 模块化电缆规范

制造商，部件编号—— Microchip Technology，07-00024

此电缆的长度（L）为6英寸。建议您不要使用长度超过6英寸的模块化电缆，以避免潜
在的通信问题。

图B-5： 模块化电缆

B.6 ICD测试接口模块

要使用此模块验证调试器是否正常工作，需执行以下操作：

1. 将调试器从目标板和计算机断开。

2. 通过模块化电缆将 ICD测试接口模块（AC164113）连接到调试器。

图B-6： MPLAB ICD 4连接到测试接口模块

3. 将调试器重新连接到计算机。

4. 通过将USB电缆连接到计算机为MPLAB ICD 4供电。

5. 启动MPLAB X IDE。确保现有项目全部关闭。

6. 选择Debug>Run Debugger/Programmer Self Test（调试>运行调试器 /编程器自
检），然后选择要测试的特定“ICD 4”并单击OK（确定）。

引脚 1

L

引脚 6

6 英寸

USB 电缆
至计算机

MPLAB® ICD 4

通过 USB 电缆从计算机供电

ICD 测试接口模块

模块化电缆
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7. 确保 ICD测试接口模块和电缆已连接。单击Yes（是）继续。

8. 在调试器的Output窗口中查看自检结果。如果测试成功运行，将显示以下内容：
Test interface PGC clock line write succeeded.
Test interface PGD data line write succeeded.
Test interface PGC clock line read succeeded.
Test interface PGD data line read succeeded.
Test interface LVP control line test succeeded.
Test interface MCLR level test succeeded.
ICD4 is functioning properly. If you are still having problems with 
your target circuit please check the Target Board Considerations 
section of the online Help.

9. 调试器通过自检后，请将 ICD测试接口模块从调试器断开。

如果任何测试失败，请检查全部连接。如果仍然失败，请在以下网址中输入 ticket：

http://support.microchip.com

将Output窗口的内容复制并粘贴到问题说明中。

B.7 目标板注意事项

应根据所选器件和应用的要求向目标板供电。

调试器不检测目标电压。VDD_TGT上有182 kΩ的负载。

根据调试器与目标板之间使用的通信类型，目标板电路有以下注意事项：

• 第2.3.2节“目标板连接电路”

• 第2.3.4节“阻止调试器正常工作的电路”

注： 如果器件的工作条件超过器件数据手册中的“绝对最大值”，可能对器件造
成永久性损坏。上述值仅代表本规范规定的极限工作条件，不代表器件在上
述极限值或超出极限值的情况下仍可正常工作。器件长时间工作在最大值条
件下，其可靠性可能受到影响。

http://support.microchip.com
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附录C 版本历史

版本A（2017年8月）

本文档的初始版本。

版本B（2017年9月）

进行了少量更新以更正框图，还进行了其他少量更正。

版本C（2018年5月）

进行了少量更正，在第4.4.2节“如何调用自举模式”和第4.4.3节“如何使用硬件工
具紧急自举固件恢复实用程序”中增加了信息，修改了第A.3节“调试器选项选择”的
说明。
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支持

简介

有关支持问题，请参见本章介绍的内容。

• 保修登记

• Microchip网站

• myMicrochip个性化通知客户服务

• 客户支持

保修登记

如果您的开发工具包中包含保修登记卡，请填写该登记卡并尽快寄出。寄出保修登记
卡的用户可收到新产品更新信息。可在Microchip网站上获得临时软件版本。

MICROCHIP网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。客户可通过该网站方便
地获取文件和信息。只要使用常用的互联网浏览器即可访问，网站提供以下信息：

• 产品支持 —— 数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以
及硬件支持文档、最新的软件版本以及归档软件

• 一般技术支持 —— 常见问题解答 （FAQ）、技术支持请求、在线讨论组以及
Microchip 顾问计划成员名单

• Microchip 业务 —— 产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活
动安排表、 Microchip 销售办事处、代理商以及工厂代表列表

myMICROCHIP个性化通知客户服务

Microchip的个人通知客户服务有助于客户了解关于所关注Microchip产品的最新信息。
注册客户可在指定产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收
到电子邮件通知。

如需注册并选择接收个性化通知的首选项，请转至：

http://www.microchip.com/pcn

点击如上链接后，打开的页面中将提供FAQ和注册详细信息。

http://www.microchip.com
http://www.microchip.com/pcn
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在选择首选项时，选择“Development Systems”（开发系统）将会在列表中填入可
用的开发工具。下面列出了主要的工具类别：

• 编译器—— Microchip C编译器、汇编器、链接器及其他语言工具的最新信息。包括
所有MPLAB C编译器、所有MPLAB汇编器（包括MPASM™汇编器）、所有MPLAB
链接器（包括MPLINK™目标链接器），以及所有MPLAB库管理器（包括MPLIB™
目标库管理器）。

• 仿真器—— MPLAB REAL ICE™仿真器的最新信息。

• 在线调试器—— Microchip在线调试器的最新信息。其中包括MPLAB ICD 3和MPLAB
ICD 4在线调试器以及PICkit™ 3和MPLAB PICkit 4在线调试器。

• MPLAB® X IDE ——关于开发系统工具的多平台（Windows®、Mac OS®和Linux®）
集成开发环境Microchip MPLAB X IDE的最新信息。

• 编程器—— Microchip编程器的最新信息。其中包括器件（生产）编程器MPLAB REAL
ICE在线仿真器、MPLAB ICD 4在线调试器、MPLAB PICkit 4在线调试器、MPLAB
PM3以及开发（非生产）编程器和PICkit 3。

• 入门/演示板——包括MPLAB入门工具包电路板、PICDEM™演示板以及各种其他
评估板。

客户支持

Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师 （FAE）

• 技术支持

客户应联系其代理商、代表或应用工程师（FAE）寻求支持。当地销售办事处也可为客
户提供帮助。本文档后附有销售办事处的联系方式。

也可通过http://support.microchip.com 获得网上技术支持。

如果您发现本文档有任何错误或者对本文档有任何建议，请通过电子邮件联系我公司
TRC经理，电子邮件地址为CTRC@microchip.com。

http://www.microchip.com/support
http://support.microchip.com
mailto:CTRC@microchip.com
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术语表

A
ANSI

美国国家标准学会，是美国负责制订和批准标准的组织。

ASCII

美国信息交换标准码是使用7个二进制位来表示每个字符的字符集编码。它包括大写和
小写字母、数字、符号以及控制字符。

B

八进制（Octal）

使用数字0-7，以8为基数的计数体制。最右边的位表示1的倍数，右边第二位表示8的
倍数，右边第三位表示82 = 64的倍数，以此类推。

本机数据大小（Native Data Size）

对于本地跟踪，Watches（观察）窗口中使用的变量长度必须与所选器件的数据存储
器长度相同：对于PIC18器件，为字节长度；对于16位器件，为字长度。

编译（Build）

编译并链接一个应用程序的所有源文件。

编译堆栈（Compiled Stack）

编译器管理的存储区域，静态分配变量的空间。当在目标器件上无法高效实现软件或
硬件堆栈时，编译堆栈将替代它们。

编译器（Compiler）

将用高级语言编写的源文件翻译成机器码的程序。

标识符（Identifier）

函数名或变量名。

表达式（Expression）

用算术或逻辑运算符分隔开的常量和 /或符号的组合。

C
C/C++

C语言是一种通用编程语言，具有简练的表达式、现代控制流和数据结构，以及丰富的
操作符。C++是C语言的面向对象版本。

COFF

公共目标文件格式。这种格式的目标文件包含机器码、调试及其他信息。
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CPU

请参见中央处理单元。

操作码（Opcode）

操作码。请参见助记符。

插件（Plug-in）

MPLAB IDE/MPLAB X IDE使用内置组件和插件模块来为各种软件和硬件工具配置系
统。可在Tools（工具）菜单下找到几个插件工具。

场景（Scenario）

MPLAB SIM软件模拟器用于激励控制的一种特定设置。

程序存储器（Program Memory）

MPLAB IDE/MPLAB X IDE ——器件中存储指令的存储区。亦指仿真器或软件模拟器中
包含下载的目标应用固件的存储器。

16位汇编器 /编译器——器件中存储指令的存储区。

程序计数器（Program Counter）

包含正在执行的指令的地址的存储单元。

程序计数器单元（Program Counter Unit）

16位汇编器——程序存储器布局的概念化表示。对于每个指令字，程序计数器将递增
2。在可执行段中，2个程序计数器单元相当于3个字节。在只读段中，2个程序计数器
单元相当于2个字节。

持久性数据（Persistent Data）

永不清零或初始化的数据。其作用是使应用程序可以在器件复位时保存数据。

重定位（Relocation）

链接器执行的一个过程，在这个过程中，为可重定位段分配绝对地址，且可重定位段
中的所有符号都更新为其新地址。

触发输出（Trigger Output）

触发输出指可在任意地址或地址范围产生的仿真器输出信号，与跟踪和断点的设置无
关。可设置任意个触发输出点。

次数计数器（Pass Counter）

每次一个事件（如执行特定地址处的一条指令）发生时都会递减1的计数器。当次数计
数器的值为零时，事件满足。可将次数计数器分配给断点和跟踪逻辑，以及在complex
trigger（复杂触发）对话框中的任何顺序执行事件。

存储类别（Storage Class）

确定与指定对象相关联存储区的存在时间。

存储器模型（Memory Model）

对于C编译器，指应用程序可使用的存储区的表示。对于PIC18 C编译器，指一种描
述，它指定指向程序存储器的指针的位数。

存储限定符（Storage Qualifier）

指明所声明对象的特殊属性（如const）。

错误 /错误文件（Error/Error File）

错误报告使程序不能继续处理的问题。而且，当问题比较明显时，错误还尽可能标识
出源文件名和行号。错误文件包含由语言工具生成的错误消息和诊断信息。
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D
DWARF

使用任意记录格式调试。DWARF是用于ELF文件的调试信息格式。

单步进入（Step Into）

这一命令与Single Step相同。Step Into（与Step Over相对）在CALL指令后，单步执
行子程序。

单步跳出（Step Out）

Step Out使您可以跳出当前正在单步执行的子程序。该命令会执行该子程序中的剩余
代码，然后在该子程序的返回地址处停止执行。

单步跳过（Step Over）

Step Over允许调试代码时不单步执行子程序。当step over一条CALL指令时，下一个
断点将设置在CALL指令后的下一条指令处。如果由于某种原因，子程序陷入无限循环
或不正确返回，下一个断点将永远执行不到。除了对CALL指令的处理外，Step Over命
令与Single Step相同。

单步执行（Single Step）

这一命令单步执行代码，一次执行一条指令。执行每条指令后，MPLAB IDE/MPLAB
X IDE更新寄存器窗口、观察变量及状态显示，使您可分析和调试指令。也可单步执行
C编译器源代码，但不是每次执行一条指令，MPLAB IDE/MPLAB X IDE将执行一行高
级C语句生成的所有汇编指令。

单片机（Microcontroller）

高度集成的芯片，它包括CPU、RAM、程序存储器、I/O端口和定时器。

单片机模式（Microcontroller Mode）

PIC18单片机的一种程序存储器配置。在单片机模式下，仅允许内部执行。因此，在单
片机模式下仅可使用片内程序存储器。

导出（Export）

以标准化的格式将数据从MPLAB IDE/MPLAB X IDE发送出。

导入（Import）

将数据从外部源（例如，hex文件）传送到MPLAB IDE/MPLAB X IDE中。

地址（Address）

标识存储器中位置的值。

递归（Recursion）

已定义的函数或宏可调用自己的概念。当编写递归宏时要特别小心；当递归没有出口
时容易陷入无限循环。

递归调用（Recursive Call）

一个直接或间接调用自身的函数。
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段（Section）

OCG psect的GCC等效形式。被链接器视为一个整体的代码块或数据块。

段属性（Section Attribute）

赋予段的GCC特性（例如，access段）。

断点（Breakpoint）

硬件断点：一个事件，执行这种事件会导致暂停。

软件断点：一个地址，固件会在这个地址处暂停执行。通常由特殊的中断指令获得。

堆（Heap）

用于动态存储器分配的存储区，其中的存储器块按运行时确定的任意顺序进行分配和
释放。

堆栈，编译（Stack, Compiled）

编译器管理和分配的存储区域，静态分配变量的空间。当在目标器件上无法高效实现
软件堆栈时，编译堆栈将替代软件堆栈。它阻止可重入。

堆栈，软件（Stack, Software）

用来存储返回地址、函数参数和局部变量的存储区。该存储器在运行时通过程序中的
指令动态分配。它支持可重入函数调用。

堆栈，硬件（Stack, Hardware）

PIC®单片机中调用函数时存储返回地址的存储区。

E
EEPROM

电可擦除的可编程只读存储器。一种可电擦除的特殊PROM。一次写或擦除一个字
节。EEPROM即使电源关闭时也能保留内容。

ELF

可执行链接格式。这种格式的目标文件包含机器码。调试和其他信息使用DWARF指
定。ELF/DWARF可提供优于COFF的优化代码调试。

EPROM

可擦除的可编程只读存储器。通常通过紫外线照射来擦除的可编程只读存储器。

二进制（Binary）

使用数字0和1，以2为基数的计数体制。最右边的位表示1的倍数，右边第二位表示2
的倍数，右边第三位表示22 = 4的倍数，以此类推。

F
FNOP

强制空操作。强制NOP周期是双周期指令的第二个周期。由于PIC单片机的架构是流
水线型，在执行当前指令的同时预取物理地址空间中的下一条指令。但是，如果当前
指令改变了程序计数器，那么这条预取的指令就被忽略了，导致一个强制NOP周期。

Free-Standing

一种接受任何不使用复杂类型的严格符合程序的实现，而且在这种实现中，对库条
款（ANSI 89标准条款第7条）中规定的特性的使用，仅限于标准头文件<float.h>、
<iso646.h>、<limits.h>、<stdarg.h>、<stdbool.h>、<stddef.h> 和
<stdint.h>的内容。
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仿真 /仿真器（Emulation/Emulator）

参见 ICE/ICD。

访问入口点（Access Entry Point）

访问入口点提供了一种方法，可跨段将控制转移到某个可能未在链接时定义的函数。
它们支持独立链接引导段和安全应用程序段。

非扩展模式（Non-Extended Mode）（PIC18 MCU）

在非扩展模式下，编译器不会使用扩展指令和立即数变址寻址。

非实时（Non Real Time）

指处理器处于断点或正在单步执行指令或者MPLAB IDE/MPLAB X IDE正运行在软件模
拟器模式下。

非易失性存储器（Non-Volatile Storage）

电源关闭时保存其内容的存储器件。

符号（Symbol）

符号是描述组成程序的不同部分的一种通用机制。这些部分包括函数名、变量名、段
名、文件名以及结构 /枚举类 /联合标记名等。MPLAB IDE/MPLAB X IDE中的符号主要
指变量名、函数名和汇编标号。链接后符号的值就是其在存储器中的值。

符号，绝对（Symbol, Absolute）

表示一个立即数的值，例如通过汇编.equ伪指令指定的定义。

G
GPR

通用寄存器。器件数据存储器（RAM）的一部分，作为一般用途。

高级语言（High Level Language）

编写程序的语言，它比汇编语言更不依赖于具体的处理器。

跟踪（Trace）

记录程序执行的仿真器或软件模拟器功能。仿真器将程序执行记录到其跟踪缓冲区
中，该缓冲区的内容将被上传到MPLAB IDE/MPLAB X IDE的 trace（跟踪）窗口。

跟踪存储区（Trace Memory）

跟踪存储区包含在仿真器内部。跟踪存储区有时称为跟踪缓冲区。

跟踪宏（Trace Macro）

一个通过仿真器数据来提供跟踪信息的宏。由于该宏属于软件跟踪，所以必须将它添
加到代码中、必须重新编译或重新汇编代码，并且必须使用该代码对目标器件进行编
程，之后跟踪才会工作。

工具条（Tool Bar）

一行或一列图标，单击这些图标时将执行MPLAB IDE/MPLAB X IDE功能。

工作簿（Workbook）

对于MPLAB SIM模拟器，是一种用于产生SCL激励的设置。

观察变量（Watch Variable）

调试会话期间可在Watches窗口中监控的变量。
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归档 /归档器（Archive/Archiver）

归档/库是可重定位目标模块的集合。由将多个源文件编译/汇编为目标文件，然后使用
归档器 /库管理器将目标文件组合为一个归档 /库文件生成。可将归档 /库与目标模块和
其他归档 /库链接，生成可执行代码。

国际标准化组织（International Organization for Standardization）

制订许多行业和技术（包括计算和通信）方面的标准的一个组织。也称为 ISO。

过滤器（Filter）

通过选择确定在跟踪显示或数据文件中包含 /排除哪些数据。

H

Halt（暂停）

停止程序执行。执行Halt与在断点处停止相同。

Hex代码 /Hex文件（Hex Code/Hex File）

hex代码是以十六进制格式代码存储的可执行指令。hex代码包含在hex文件中。

宏（Macro）

宏指令。以缩写形式表示指令序列的指令。

宏伪指令（Macro Directive）

控制宏定义体中执行和数据分配的伪指令。

环回测试板（Loop-Back Test Board）

用于测试MPLAB REAL ICE在线仿真器的功能。

环境（Environment）

MPLAB PM3 ——包含关于如何编程器件的文件的文件夹。该文件夹可以转移到
SD/MMC卡。

汇编语言 /汇编器（Assembly/Assembler）

汇编语言是以符号形式描述二进制机器码的编程语言。汇编器是将汇编源代码翻译成
机器码的语言工具。

I
ICE/ICD

在线仿真器 /在线调试器：用于对目标器件进行调试和编程的硬件工具。仿真器具有比
调试器更多的功能，例如跟踪。

在线仿真 /在线调试：使用在线仿真器或调试器进行仿真或调试的行为。

-ICE/-ICD：带有在线仿真或调试电路的器件（MCU或DSC）。该器件总是安装在仿真/
调试头板上，并用于通过在线仿真器或调试器进行调试。

ICSP

在线串行编程。使用串行通信和最少数量的器件引脚对Microchip嵌入式器件进行编程
的方法。

IDE

集成开发环境，如MPLAB IDE/MPLAB X IDE。

IEEE

电气电子工程师协会。
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J

机器码（Machine Code）

处理器实际读和解释的计算机程序的表示。二进制机器码程序由一系列机器指令（可
能还包含数据）组成。某个特定处理器的所有可用指令的集合称为它的“指令集”。

机器语言（Machine Language）

特定中央处理单元的指令集，不需翻译即可供处理器使用。

基数（Radix）

数基，十六进制或十进制，用于指定一个地址。

激励（Stimulus）

软件模拟器的输入（即为模拟对外部信号的响应而生成的数据）。通常数据采用文本
文件中一系列动作的形式。激励可以是异步的，同步的（引脚），时钟激励和寄存器
激励。

交叉引用文件（Cross Reference File）

引用符号表的一个文件及引用符号的文件列表。如果定义了符号，列出的第一个文件
是定义的位置。其他文件包含对符号的引用。

校准存储区（Calibration Memory）

用于保存PIC单片机内RC振荡器或其他外设校准值的特殊功能寄存器或通用寄存器。

节点（Node）

MPLAB IDE/MPLAB X IDE项目组件。

结语（Epilogue）

编译器生成代码的一部分，负责释放堆栈空间、恢复寄存器，以及执行运行时模型中
指定的任何其他特定于机器的要求。此代码在给定函数的任何用户代码之后、在函数
返回之前执行。

精简（Relaxation）

将某一指令转换为功能相同但大小较小的指令的过程。这对于缩短代码长度非常有
用。MPLAB XC16目前知道如何将CALL指令relax为RCALL指令。当被调用的符号处
于当前指令的+/- 32k指令字范围内时，将会执行该操作。

警告（Warning）

MPLAB IDE/MPLAB X IDE ——提供警告，警告您发生了可能导致器件、软件文件或设
备物理损坏的情况。

MPLAB XC16汇编器 /编译器——警告报告可能发生问题的情况，但并不停止处理。 

静态RAM或SRAM（Static RAM or SRAM）

静态随机访问存储器。目标板上可读 /写且不需要经常刷新的程序存储器。

局部标号（Local Label）

局部标号是用LOCAL伪指令在一个宏内部定义的标号。这些标号特定于宏实例化的一
个给定实例。也就是说，声明为 local的符号和标号在遇到ENDM宏后不再可访问。
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绝对变量 /函数（Absolute Variable/Function）

使用OCG编译器的@ address语法放置在绝对地址的变量或函数。

绝对段（Absolute Section）

具有链接器不能改变的固定（绝对）地址的GCC编译器段。

K

看门狗定时器（Watchdog Timer，WDT）

PIC单片机中在一段可选择长度的时间后复位处理器的定时器。使用配置位来使能、禁
止和设置WDT。

可重定位（Relocatable）

一个对象，它的地址没有分配到存储器中的固定地址。

可重定位段（Relocatable Section）

16位汇编器——地址不固定（绝对）的段。链接器通过一个称为重定位的过程来为可
重定位段分配地址。

可重入函数（Reentrant）

可以有多个同时运行的实例的函数。在下面两种情况下可能发生函数重入：直接或间
接递归调用函数；或者在由函数转入的中断处理过程中又执行此函数。

可执行代码（Executable Code）

可装入来执行的软件。

控制伪指令（Control Directive）

汇编语言代码中根据汇编时指定表达式的值包含或忽略代码的伪指令。

库 /库管理器（Library/Librarian）

参见归档 /归档器。

快速存取存储区（Access Memory）

仅限PIC18 —— PIC18器件中的一些特殊寄存器，对这些寄存器的访问与存储区选择寄
存器（Bank Select Register，BSR）的设置无关。

扩展单片机模式（Extended Microcontroller Mode）

在扩展单片机模式下，既可使用片内程序存储器，也可使用外部存储器。如果程序存
储器地址大于PIC18器件的内部存储空间，执行自动切换到外部存储器。

扩展模式（Extended Mode）（PIC18 MCU）

在扩展模式下，编译器将使用扩展指令（即ADDFSR、ADDULNK、CALLW、MOVSF、
MOVSS、PUSHL、SUBFSR和SUBULNK）以及立即数变址寻址。
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L
LVDS

低电压差分信号传输。一种通过铜线进行高速（每秒千兆位）数据传输的低噪声、低
功耗、低幅值方法。 

对于标准 I/O信号传输，数据存储依赖于实际电压大小。电压值会受线路长度影响（线
路越长，电阻就越高，这会使电压下降）。但对于LVDS，存储数据仅通过正负电压值
判断，而不是实际电压大小。因此，数据可以传输更长的线路距离，同时保持干净、
一致的数据流。

来源：http://www.webopedia.com/TERM/L/LVDS.html

链接描述文件（Linker Script File）

链接描述文件是链接器的命令文件。它们定义链接选项并描述目标平台上的可用存储器。

链接器（Linker）

将目标文件和库文件组合起来生成可执行代码并解析一个模块对另外一个模块引用的
语言工具。

列表伪指令（Listing Directive）

列表伪指令是控制汇编器列表文件格式的伪指令。它们允许指定标题、分页及其他列
表控制。

列表文件（Listing File）

列表文件是列出为每条C源语句生成的机器码、源文件中遇到的汇编指令、汇编器伪指
令或宏的ASCII文本文件。

逻辑探头（Logic Probe）

Microchip的某些仿真器最多可连接14个逻辑探头。逻辑探头提供外部跟踪输入、触发
输出信号、+5V和公共接地端。

逻辑与断点（ANDed Breakpoint）

为中断设置“逻辑与”条件，即只有断点1和断点2同时出现时，才会暂停程序。只有
数据断点和程序存储器断点同时出现时，才会完成它。

M
Makefile

将用于Make项目的指令导出到一个文件中。可使用该文件通过make指令在MPLAB
IDE/MPLAB X IDE外Make项目。

Make项目（Make Project）

重新编译应用程序的命令，仅编译自上次编译完成后更改了的源文件。

MCU

单片机。microcontroller的缩写形式。也写作uC。

MPASM™汇编器（MPASM™ Assembler）

Microchip Technology用于PIC单片机、KeeLoq®器件和Microchip存储器件的可重定位
宏汇编器。

http://www.webopedia.com/TERM/L/LVDS.html
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MPLAB ICD

Microchip的在线调试器，与MPLAB IDE/MPLAB X IDE配合使用。参见 ICE/ICD。

MPLAB IDE/MPLAB X IDE

Microchip的集成开发环境。MPLAB IDE/MPLAB X IDE随附编辑器、项目管理器和软
件模拟器。

MPLAB PM3

Microchip的器件编程器。用于对PIC18单片机和dsPIC®数字信号控制器进行编程。可
与MPLAB IDE/MPLAB X IDE配合使用，也可单独使用。代替PRO MATE II。

MPLAB REAL ICE™在线仿真器（MPLAB REAL ICE™ In-Circuit Emulator）

Microchip的新一代在线仿真器，与MPLAB IDE/MPLAB X IDE配合使用。参见ICE/ICD。

MPLAB SIM

Microchip的软件模拟器，可与MPLAB IDE/MPLAB X IDE配合使用，支持PIC MCU和
dsPIC® DSC器件。

MPLIB™目标库管理器（MPLIB™ Object Librarian）

Microchip的库管理器，可与MPLAB IDE/MPLAB X IDE配合使用。MPLIB库管理器是
用于将由MPASM™汇编器（mpasm或mpasmwin v2.0）或MPLAB C18 C编译器生成
的COFF目标模块组合成库文件的目标库管理器。

MPLINK™目标链接器（MPLINK Object Linker）

MPLINK链接器是Microchip MPASM汇编器和Microchip C18 C编译器的目标链接器。
也可将MPLINK链接器与Microchip MPLIB库管理器配合使用。MPLINK链接器设计为
与MPLAB IDE/MPLAB X IDE配合使用，但是它并不一定要与MPLAB IDE/MPLAB X
IDE配合使用。

MRU

最近使用的。指可从MPLAB IDE/MPLAB X IDE主下拉菜单中选择的文件和窗口。

命令行接口（Command Line Interface）

仅基于文本输入和输出，在程序和其用户之间进行通信的一种方式。

模块（Module）

源文件在执行预处理器伪指令之后的预处理输出。也称为翻译单元。

模板（Template）

为以后插入自己的文件中使用而创建的文本行。MPLAB编辑器将模板存储到模板文
件中。

目标（Target）

指用户硬件。

目标板（Target Board）

构成目标应用的电路和可编程器件。
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目标处理器（Target Processor）

目标应用板上的单片机。

目标代码 /目标文件（Object Code/Object File）

目标代码是由汇编器或编译器生成的机器码。目标文件是包含机器码，也可能包含调
试信息的文件。它可以直接执行；或为可重定位的，需要与其他目标文件（如库文
件）链接来生成完全可执行的程序。

目标文件伪指令（Object File Directive）

仅当生成目标文件时使用的伪指令。

目标应用程序（Target Application）

目标板上的软件。

N
NOP

空操作。执行该指令时，除了程序计数器加1外没有任何其他影响。

内部链接（Internal Linkage）

如果不能从定义函数或变量的模块外部访问它们，则这样的函数或变量具有内部链接。

匿名结构（Anonymous Structure）

MPLAB XC16 C编译器——未命名的结构。

MPLAB XC8 C编译器——属于C联合成员的未命名结构。匿名结构的成员可以像外围
联合的成员一样进行访问。例如，在以下代码中，hi和lo是联合caster中的匿名结
构的成员。

union castaway
 int intval;
 struct {
  char lo; //accessible as caster.lo
  char hi; //accessible as caster.hi
 };
} caster;

O
OTP

可一次编程。非窗口封装的EPROM器件。由于EPROM需要紫外线照射来擦除其存储
内容，因此只有窗口片是可擦除的。

P
PC

个人计算机或程序计数器。

PC主机（PC Host）

运行有一个支持的Windows操作系统的任何PC。

PIC MCU

PIC单片机（MCU）指Microchip的所有单片机系列。
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PICkit 2和3

Microchip的器件开发编程器，通过Debug Express实现调试功能。要了解每个工具支
持哪些器件，请参见每个工具的自述文件。

Pragma伪指令（Pragma）

对特定编译器有意义的伪指令。通常一条pragma伪指令用于向编译器传达实现定义的
信息。

Prologue

编译器生成代码的一部分，负责分配堆栈空间、保存寄存器，以及执行运行时模型中
指定的任何其他特定于机器的要求。此代码在给定函数的任何用户代码之前执行。

Psect

GCC段的OCG等效形式，program section（程序段）的缩写。被链接器视为一个整体
的代码或数据块。

PWM信号（PWM Signal）

脉宽调制信号。某些PIC MCU包含PWM外设。

跑表（Stopwatch）

测量执行周期的计数器。

配置位（Configuration Bits）

可对其编程来设置PIC MCU或dsPIC DSC工作模式的专用位。配置位可或不可再编程。

配置文件（Profile）

对于MPLAB SIM软件模拟器，寄存器已执行激励的汇总列表。

16位汇编器 /编译器——器件中存储指令的存储区。

片外存储器（Off-Chip Memory）

片外存储器指PIC18器件的一种存储器选择，这种情况下存储器可位于目标板上，或所
有程序存储器都由仿真器提供。从OptionsDevelopment Mode访问Memory选项卡可
打开Off-Chip Memory Selection对话框。

Q

弃用功能（Deprecated Feature）

由于历史原因仍然支持但最终将逐步淘汰且不再使用的功能。

器件编程器（Device Programmer）

用于对电可编程半导体器件（如单片机）进行编程的工具。

器件的MPLAB入门工具包（MPLAB Starter Kit for Device）

Microchip的入门工具包中包含着手研究指定器件所需的全部内容。查看有效工作的应
用程序，然后调试和编程您自己的更改。

器件的MPLAB语言工具（MPLAB Language Tool for Device）

用于指定器件的Microchip的C编译器、汇编器和链接器。根据应用中所使用的器件来
选择语言工具类型。例如，如果为PIC18 MCU编写C代码，就选择用于PIC18 MCU的
MPLAB C编译器。
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嵌套深度（Nesting Depth）

宏可包含其他宏的最大深度。

清除（Clean）

清除会删除活动项目的所有中间项目文件，例如目标文件、hex文件和调试文件。编译
项目时，将基于其他文件重新创建这些文件。

R
RAM

随机访问存储器（数据存储器）。可以以任意顺序访问这种存储器中的信息。

ROM

只读存储器（程序存储器）。不能修改的存储器。

软件模拟器（Simulator）

模仿器件操作的软件程序。

S
Shell

MPASM汇编器shell是宏汇编器的提示输入接口。有两个MPASM汇编器shell：一个针
对DOS版本，一个针对Windows操作系统版本。

Skew

不同时间出现在处理器总线上与指令执行有关的信息。例如，执行前一条指令的过程
中取指时，被执行的操作码出现在总线上；当实际执行该操作码时，源数据地址及其
值以及目标数据地址出现在总线上。当执行下一条指令时，目标数据值出现在总线
上。跟踪缓冲区一次捕捉总线上的这些信息。因此，跟踪缓冲区的一条记录将包含三
条指令的执行信息。执行一条指令时，从一条信息到另一条信息的捕捉周期数称为
skew。

Skid

当使用硬件断点来暂停处理器时，在处理器暂停前可能再执行一条或多条指令。断点
后执行的指令条数称为skid。

SQTP

参见带序列号的快速批量编程。

三字母词（Trigraph）

由三个字符组成的序列，均以??开头，由 ISO C定义用于替代单个字符。

闪存（Flash）

按块（而不是按字节）写或擦除数据的一种EEPROM。

上电复位仿真（Power-on-Reset Emulation）

在应用开始上电时，将随机值写到数据RAM区中来模拟RAM中的未初始化值的软件随
机过程。

上传（Upload）

上传功能将数据从一个工具（如仿真器或编程器）传送到主机计算机，或将数据从目
标板传送到仿真器。



MPLAB® ICD 4用户指南 

 DS50002596C_CN 第88页  2018 Microchip Technology Inc.

生产编程器（Production Programmer）

生产编程器是一种编程工具，其中设计了可对器件进行快速编程的资源。它具有在各
种电压下进行编程的能力并完全符合编程规范。在生产环境中，应用电路需要在组装
线上传送，时间是极其重要的，所以尽可能快地对器件编程至关重要。

十六进制（Hexadecimal）

使用数字0-9以及字母A-F（或a-f），以16为基数的计数体制。字母A-F表示（十进制
中）值为10-15的十六进制数。最右边的位表示1的倍数，右边第二位表示16的倍数，
右边第三位表示162 = 256的倍数，以此类推。

实时（Real Time）

当在线仿真器或调试器从暂停状态释放时，处理器以实时模式运行且与芯片的正常操
作相同。在实时模式下，使能仿真器的实时跟踪缓冲区，并持续捕捉所有选择的周
期，使能所有断点逻辑。在在线仿真器或调试器模式下，处理器实时运行，直到有效
断点导致暂停，或者直到用户暂停执行。

在软件模拟器模式下，实时仅意味着单片机指令的执行速度与主机CPU可模拟的指令
速度一样快。

事件（Event）

对可能包含地址、数据、次数计数、外部输入、周期类型（取指和读 /写）及时间标记
的总线周期的描述。事件用于描述触发、断点和中断。

书签（Bookmarks）

使用书签可轻松地查找文件中的指定行。

在Editor（编辑器）工具栏中选择Toggle Bookmarks（开关书签）可添加 /删除书签。
单击该工具栏上的其他图标可移动到下一个或上一个书签。

属性（Attribute）

C程序中变量或函数的GCC特性，用于描述特定于机器的性质。

属性，段（Attribute, Section）

段的GCC特性，如“可执行”、“只读”或“数据”，它们可在汇编器.section伪
指令中指定为标志。

数据存储器（Data Memory）

在Microchip MCU和DSC器件中，数据存储器（RAM）由通用寄存器（GPR）和特殊
功能寄存器（SFR）组成。某些器件还有EEPROM数据存储器。

数据监视与控制界面（Data Monitor and Control Interface，DMCI）

数据监视与控制界面（DMCI）是MPLAB X IDE中的一个工具。该界面可以对项目中的
应用程序变量提供动态输入控制。应用程序生成的数据可以使用4个可动态分配图形窗
口中的任意一个以图形方式进行查看。
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数据伪指令（Data Directive）

数据伪指令是那些控制汇编器对程序存储器或数据存储器进行分配的指示性语句，它
提供了用符号（即有意义的名称）引用数据项的方法。

数字信号处理/数字信号处理器（Digital Signal Processing/Digital Signal Processor）

数字信号处理（DSP）指数字信号以及已转换为数字形式（经过采样的）的一般模拟
信号（声音或图像）的计算机处理。数字信号处理器是设计为用于数字信号处理的微
处理器。

数字信号控制器（Digital Signal Controller）

数字信号控制器（DSC）是具有数字信号处理能力的单片机（即Microchip的dsPIC
DSC器件）。

顺序断点（Sequenced Breakpoint）

按顺序发生的断点。断点的执行顺序为从下到上；序列中的最后一个断点最先发生。

T

特殊功能寄存器（Special Function Register，SFR）

数据存储器（RAM）的一部分，专用于控制 I/O处理器函数、I/O状态、定时器或其他
模式及外设的寄存器。

条件编译（Conditional Compilation）

只有当预处理器伪指令指定的某个常量表达式为真时才编译程序段的操作。

条件汇编（Conditional Assembly）

基于指定表达式在编译时的值包含或忽略的汇编语言代码。

调试 /调试器（Debug/Debugger）

参见 ICE/ICD。

调试信息（Debugging Information）

编译器和汇编器选项，在选中时，它们将提供不同程度的信息来用于调试应用程序代
码。关于选择调试选项的详细信息，请参见编译器或汇编器文档。

U
USB

通用串行总线。是计算机和外设之间通过电缆以双向串行传输方式通信的外部外设接
口标准。USB 1.0/1.1支持12 Mbps的数据传输速率。USB 2.0也称为高速USB，它支
持最高480 Mbps的数据传输速率。

W

Watches窗口（Watches Window）

Watches窗口包含一系列观察变量，这些变量在每次执行到断点时更新。

外部RAM（External RAM）

芯片外部的读 /写存储器。
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外部标号（External Label）

具有外部链接的标号。

外部符号（External Symbol）

具有外部链接的标识符符号。这可能是一个引用或一个定义。

外部符号解析（External Symbol Resolution）

链接器收集所有输入模块的外部符号定义来解析所有外部符号引用的过程。没有相应
定义的任何外部符号引用都会导致报告链接器错误。

外部链接（External Linkage）

如果可以在定义函数或变量的模块外部对函数或变量进行引用，则函数或变量具有外
部链接。

外部输入线（External Input Line）

用于根据外部信号设置事件的外部输入信号逻辑探头线（TRIGIN）。

微处理器模式（Microprocessor Mode）

PIC18单片机的一种程序存储器配置。在微处理器模式下，不使用片内程序存储器。整
个程序存储器映射到外部。

伪指令（Directive）

源代码中提供对语言工具的操作进行控制的语句。

尾数法（Endianness）

多字节对象中的字节存储顺序。

未初始化数据（Uninitialized Data）

定义时未指定初始值的数据。在C中，

int myVar; 

定义了将存放到未初始化数据段的一个变量。

未分配段（Unassigned Section）

在链接器命令文件中未分配到特定目标存储区的段。链接器必须找到用于分配未分配
段的目标存储区。

文件寄存器（File Register）

片内数据存储器，包括通用寄存器（GPR）和特殊功能寄存器（SFR）。

X

系统窗口控件（System Window Control）

系统窗口控件位于窗口和某些对话框的左上角。单击该控件时通常会弹出包含
“Minimize”（最小化）、“Maximize”（最大化）和“Close”（关闭）项的菜单。

下载（Download）

下载是将数据从主机发送到其他设备（如仿真器、编程器或目标板）的过程。

限定符（Qualifier）

次数计数器使用的地址或地址范围，或用作复杂触发中另一个操作之前的事件。
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响应延时（Latency）

事件与其得到响应之间的延迟时间。

向量（Vector）

复位或中断发生时应用程序跳转到的存储地址。

项目（Project）

项目包含编译应用程序所需的文件（源代码和链接描述文件等），以及它们与各种编
译工具和编译选项的关联。

消息（Message）

显示出来的文本，警告在语言工具的操作中可能存在的问题。消息不会停止操作。

小尾数法（Little Endian）

是多字节数据的数据存储顺序方案，最低有效字节存储在低地址中。

修正（Fixup）

在链接器重定位之后，使用绝对地址替换目标文件符号引用的过程。

虚拟字节（Phantom Byte）

dsPIC架构中的未实现字节，在将24位指令字视为32位指令字时使用。虚拟字节出现
在dsPIC hex文件中。

序列号快速批量编程（Serialized Quick Turn Programming）

序列化使您可以将序列号编程到器件编程器进行编程的每个单片机中。该编号可用作
记录代码、密码或 ID号。

Y

样机系统（Prototype System）

指用户的目标应用或目标板的术语。

已初始化数据（Initialized Data）

用初始值定义的数据。在C中，

int myVar=5;

定义了将存放到已初始化数据段中的一个变量。

已分配段（Assigned Section）

在链接器命令文件中已分配到目标存储区的GCC编译器段。

异步（Asynchronously）

不同时发生的多个事件。通常用来指可能在处理器执行过程中的任意时刻发生的中断。

异步激励（Asynchronous Stimulus） 

为模拟传递到软件模拟器件的外部输入而生成的数据。

易失性（Volatile）

一个变量限定符，它可以防止编译器应用会影响变量在存储器中的访问方式的优化。

应用（Application）

可以由PIC单片机控制的一组软件和硬件。
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优先顺序（Precedence）

定义表达式中求值顺序的规则。

原始数据（Raw Data）

与一个段有关的代码或数据的二进制表示。

源代码（Source Code）

编程人员编写计算机程序的形式。采用某种正式的编程语言编写源代码，可翻译成机
器码或被解释程序执行。

源文件（Source File）

包含源代码的ASCII文本文件。

运算符（Operator）

加号“+”和减号“-”之类的符号，它们在构成定义明确的表达式时使用。每个运算
符都具有指定的优先级，用于确定求值的顺序。

运行（Run）

将仿真器从暂停状态释放，允许仿真器实时运行应用代码、实时改变 I/O状态或实时响
应 I/O的命令。

运行时观察（Runtime Watch）

Watches（观察）窗口，其中的变量会在应用程序运行时更改。要确定如何设置运行
时观察，请参见相应的工具文档。并不是所有工具都支持运行时观察。

运行时模型（Run-time Model）

描述目标架构资源的使用。

Z

帧指针（Frame Pointer）

引用堆栈中地址，并将基于堆栈的参数和基于堆栈的局部变量分隔开的指针。为访问
当前函数的局部变量和其他值提供了方便。

只读存储器（Read Only Memory）

存储器硬件，它允许快速访问其中永久存储的数据，但不允许添加或修改数据。

指令（Instruction）

告知中央处理单元执行特定操作，并包含操作中要使用的数据的位序列。

指令集（Instruction Set）

特定处理器理解的机器语言指令的集合。

致命错误（Fatal Error）

引起编译立即停止的错误。不产生其他消息。

中断（Interrupt）

传递到CPU的信号，它使CPU暂停执行正在运行的应用程序，将控制权转交给中断服
务程序（ISR），以处理事件。在完成 ISR时，将恢复应用程序的正常执行。
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中断处理程序（Interrupt Handler）

发生中断时处理特殊代码的子程序。

中断服务程序（Interrupt Service Routine，ISR）

语言工具——用于处理中断的函数。

MPLAB IDE/MPLAB X IDE ——在产生中断时进入的用户生成的代码。代码在程序存储
器中的位置通常取决于所产生中断的类型。

中断服务请求（Interrupt Service Request，IQR）

使处理器暂停正常的指令执行并开始执行中断处理程序的事件。某些处理器有几种中
断请求事件，允许具有不同优先级的中断。

中断向量（Interrupt Vector）

中断服务程序或中断处理程序的地址。

中央处理单元（Central Processing Unit）

器件的一部分，负责取出要执行的正确指令，对指令进行译码，然后执行指令。如果
有必要，它和算术逻辑单元（Arithmetic Logic Unit，ALU）一起工作来完成指令的执
行。它控制程序存储器的地址总线、数据存储器的地址总线和对堆栈的访问。

主机（Pod）

在线仿真器或调试器的机身。其他名称还有“Puck”（如果外壳是圆的）和“Probe”
（不要与逻辑探头混淆）。

助记符（Mnemonic）

可直接翻译成机器码的文本指令。也称为操作码。

状态栏（Status Bar）

状态栏位于MPLAB IDE/MPLAB X IDE窗口的底部，指示诸如光标位置、开发模式、器
件和有效工具栏之类的当前信息。

字母数字字符（Alphanumeric）

字母数字字符由字母字符和十进制数字（0,1, …,9）组成。

字母字符（Alphabetic Character）

字母字符指属于拉丁字母表（a,b,…,z,A,B, …,Z）中字母的字符。

左值（L-value）

引用可被检查和 /或修改的对象的表达式。左值表达式用在赋值的左侧。
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注：
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